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Under Display Setup, choosing overlaid titles and displaying multiple spectra with the Digital Signature 
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resultant file would be larger than is supported. Also file creation to return 0 if too many spectra in 
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About This Document 
 
This document contains information about the OMNIC™ version 8.3, 8.2, 8.1 SP1, 8.1, 8.0 SP1, 
8.0, 7.4.1, 7.4, 7.3 Service Pack 1 (SP1), 7.3, 7.2a, 7.2, 7.1a, 7.1, 7.0, 6.2, 6.1a and version 6.1 
software suite, including new features, questions from our users and known issues. 

 
About OMNIC 
 
Thermo Scientific OMNIC software is a full-featured package that provides all the tools necessary 
for Fourier transform infrared (FT-IR) and Raman analysis. OMNIC software allows you to quickly 
and easily collect, process, analyze and manage your FT-IR or Raman data in a graphical 
environment that is customizable and easy to learn. It is the common platform used by all Thermo 
Scientific laboratory spectrometers and is the heart of the Thermo Scientific Smart System 
approach to spectroscopy, providing a critical level of integration between software, spectrometer 
and sampling accessory. 
 
OMNIC 8.3 is a spectroscopy software package that runs in Windows® XP Professional, Windows 
Vista® Business, Windows 7 Professional 32-bit, or Windows 7 Professional 64-bit. Consult the 
computer requirements document for additional requirements for individual hardware or software 
components. Earlier versions of OMNIC could be used on other versions of Windows. 
 
OMNIC v8.3 
 
New Features 
 
Windows 7, 64 bit support 

Description: OMNIC 8.3 is now supported on systems with Windows 7 Professional edition, 64 
bit version. 

 
Resolved Issues 
 
OMNIC 
 
IR200, Corrected problems with background handling  

Description:  Beginning with OMNIC 8.2, the data spacing adjustment for the instrument’s 
diode laser was not applied correctly when the background was measured resulting in invalid 
background errors. 
 

iS5, Corrected occasional iD5 accessory test errors 
Description:  Occasionally the automated accessory test, which runs when the iD5 accessory 
was attached, would initially indicate a failure but always succeed when re-tried. 
 

iS10, Corrected error in the iTR experiment file affecting spectral interpretation 
Description:  An incorrect value in the iTR experiment file for iS10 prevented the Spectral 
Interpretation operation from producing the expected result. 
 

Revised installation process to eliminate compatibility problems with McAfee Update Agent  
Description:  On some systems with McAfee, the McAfee Update Agent would no longer run 
properly after installation of the OMNIC software. 
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Known Issues 
 
OMNIC 
 
ACD Structures optional software is no longer available 

Description:  This package is incompatible with Windows 7 and has been removed.  
 

 
 

OMNIC v8.2  
 
New Features 
 
System Performance Verification (SPV)  

Description: The SPV feature has been enhanced to support the new Nicolet™ iS™5 
instrument. A check box has been added to the System Suitability test to do an auto tune at the 
start of the test. 
 

Nicolet iS5 
Description: Added support for the Nicolet iS5 spectrometer. This includes the laser 
calibration, warm up time when the instrument is first started and a prompt to run PV when the 
instrument is first used. 
 

Antaris IGS II 
Description: Added support for the IGS II spectrometer and data collection in series at high 
speed. 
How to use 5 Hz, 0.5cm-1 series collect: 

 Set the following parameters in Experiment setup 
 On Collect tab set 

 No. of scans = 4 
 Resolution = 0.5 
 Turn off automatic atmospheric suppression 

 On Bench tab set 
 Optical velocity = 8.2277 

 On Advanced tab set 
 Zero filling = none 
 Sample spacing = 2 

 On Series tab set 
 Data collection type = High speed real time 

 This collects full spectra using the bidirectional collect. 
 Profiles – If using quant method, do not select “Use quant method 

from file” as this will prevent creation of the CNC file. Use the main 
quant setup under Analyze menu. 

 Select “Gas Cell” and setup the parameters to use default values or 
read from the gas parameters if hardware available. 

 A quant method for the reverse scan can be selected by checking the 
“Use reverse quant” and selecting “Setup Reverse Quant” to choose a 
quant method developed for the reverse stroke of the bidirectional 
scan. This is used to enhance the performance of the series collect. 

 Select the OK button on Experiment setup. 
 Select Collect Series and run it as described in the documentation. 
 Setting up a Reverse quant method. 

 This quant method is used when “Use reverse quant” is selected in Series 
setup. 
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 Collect background by using the “Collect Background (bidirectional)…” 
command. This will create a forward and reverse background set which can be 
saved to disk as an SPG file. 

 Collect a standard by using the “Collect Sample (bidirectional)…” command. 
This will collect two spectra, forward and reverse. 

 Create the TQ quant method as described in the documentation. 
 Create a second TQ method by copying the completed first method to a new 

file. Change the standards in this method to be the reverse spectra collected 
earlier. So that one method is using forward spectra and the other method has 
the reverse spectra. 

 
Windows 7 support 

Description: OMNIC 8.2 is compatible with Windows 7 Professional edition. 64 bit versions of  
Windows are not supported. 

 
JCAMP Multifile read and write 

Description: Add support for JCAMP MultiFile read and write. 
 
Spectra signatures in Reports 

Description: A report field has been added to show the signature of a spectrum in a report. 
 
SST – Support for new GaGe card 

Description: Support for new GaGe Razor 1422 card for TRS 
 

Windows 7 –Setting up an automated performance verification 
Description: The steps for setting up an automated performance verification have changed for 
the Windows 7 operating system.  The user documentation should read as follows: 
 
If Performance Verification is available on your system, you can have a verification run 
automatically at a scheduled time using the internal validation wheel.  You use the Task 
Scheduler wizard in Windows to set up the software for verification. 
 
In Windows 7: 
 

 For View By Category:  Click Start > Control Panel > System & Security > 
Administrative Tools > Task Scheduler to launch the Task Scheduler application. 
For View By Large or Small Icons:  Click Start > Control Panel > Administrative 
Tools > Task Scheduler to launch the Task Scheduler application. 
 

 Choose “Create Basic Task” in the Actions panel of the Task Scheduler and then follow 
the wizard’s instructions.  Enter a task name and optional description and configure the 
trigger information as desired.  When asked what action you want the task to perform, 
select Start A Program.  Then use the Browse button to locate and select the file 
named omnic32.exe.  This file is typically in C:\Program Files\OMNIC; the specific 
location depends on where you installed OMNIC. 

 
In the Add Arguments text box enter the following: 
-C”PerfVerifyTest; Select All; DeleteSelectedSpectra; Exit” 
 
Type this text exactly as it appears above, including the quotation marks, copying the 
text from here may not work. 
 
When the “Open the Properties Dialog For This Task When I Click Finish” check box 
appears, select it and then choose Finish.  A dialog box appears.  Select “Run only 
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when user is logged on” in the General tab.  Set the parameters on the other tabs as 
desired and then choose OK.   
Note:  Selecting the option to “Run when user is not logged on” on the General tab will 
not work as expected for launching a PV test. 

 
 
Resolved Issues 
 
OMNIC 
 
Print button is disabled in search result window when using OMNIC DS 

Description:  If the system policy “prevent printing, cutting or copying of unsaved data” is 
activated the customer is unable to print from the search result window.  
 

Added two types to Options parameter XAxisMode 
Description:  The types “NanometerXAxis” and “ElectronVoltXAxis” were added to the DDE 
parameter for the XaxisMode. The settings were available from the Options dialog in Omnic but 
not from the DDE parameter.  

 
Combining Large Spectral Groups in OMNIC 8 Fails 

Description:  Unable to combine two large spectral groups into one file on disk.  
 
iS10 filter wheel remains in beampath after ValPro run 

Description:  The filter wheel did not switch to the open position after the ValPro test was run.  
 
Collect sample error on 4th scan 

Description:  During a background collection the software crashed when the collect reached 
the 4th scan. 

 
Nexus benches with new sources show Source Current 

Description:  After source replacement the sources work but they fail the source current low 
limit test. 

 
Software crash when multiple spectra are opened 

Description:  When using OMNIC DS 8.0 and opening multiple spectra OMNIC displays an 
unexpected error Caution box. 

 
Cannot change X axis scale to nanometers via DDE command 

Description:  Omnic returns an error when the DDE command is used to set the X axis scale to 
nanometers. 

 
Search 
 
Search Libraries and Groups error 

Description:  When making a library list a group  the following error message would appear 
“The library or path in the group was not found”. The error message is confusing. 

 
Series 
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No Prompt for Temperature or Pressure when required by quant method 
Description:  When the TQ quant method required a prompt for temperature or pressure, the 
series collect would not prompt. 

 
Unable to import TGA data with negative values 

Description:  Negative values are occasionally used in the TGA data. This prevented 
importing of the data into the series run. 

 
Cannot create correlation map profile on reprocessed rapid scan data 

Description:  Rapid scan data set collected and reprocessed to absorbance. When profile run 
error message “Cannot recalculate reconstructions with interferograms or single beam spectra. 
Please change the final format” 

 
TQ Gas Quant method corruption leads to erroneous Series CNC file 

Description:  Using a TQ quant method that reports errors results in a CNC file with zeros for 
all the quant values and times of zero when a profile is run. 

 
Macros Basic 
 
Macros Basic delay does not keep accurate time 

Description:  When using a macros basic delay task, it does not keep accurate time. 
 
Macros Basic cannot open more than one file 

Description:  Macro is setup to open several files, when executed with several files there was 
an error. 

 
OMNIC DS Data Security 
 
Remove Run OMNIC Only 

Description:  The system policy “Run OMNIC only” cannot be supported in Windows VISTA or 
Windows 7.  
 

Digital signature not shown on reports 
Description:  The spectrum digital signature was not shown on the spectrum in a report. 
 

SST and TRS 
 
 
OMNIC v8.1 SP1 
 
Resolved Issues 
 
Experiment files were getting saved with the Validation Wheel set to the NG11 position after 
a ValPro run. 

Description:  In previous versions of the software sometimes experiment files were saved with the 
Validation Wheel set to the NG11 position after a ValPro™ software run which would then leave the 
wheel in a position other than home which was not acceptable.  The only work around was to restart the 
OMNIC application following a ValPro run.  Now the experiment file settings are set properly so that the 
correct position is stored following a ValPro run.  All experiment files that were saved previously will be 
adjusted at runtime to correct the issue also. 
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Sample collection crashes when monitoring ValPro methods for both the main FTIR 
instrument and one or more accessories using SPV, the collect background before sample 
option is selected in Experiment Setup and you are using the 21CRF11 option. 

Description:  The software generates an unhandled exception on the 4th scan of the sample 
collection following a successful background collection when certain ValPro methods are 
monitored in SPV and TSA is being used.  When all of these conditions are met a buffer 
overflow exception was thrown because of a long description being generated.  This issue has 
been addressed and will no longer occur. 

 
OMNIC v8.1  
 
New Features 
 
QCheck printout now indicates High Sensitivity option 

Description:  The result window now displays text indicating the High Sensitivity setting used 
during the processing.   

 
Resolved Issues 
 
OMNIC 

 
OMNIC version 5.1a quant methods now quantify correctly using OMNIC 8.0 SP1 

Description:  Quant methods created with OMNIC version 5.1a now quantify correctly with 
OMNIC 8.0 SP1 software.  They caused an error to occur when used with OMNIC 8.0. 
 

Validation wheel positioning 
Description:  Prior to auto-aligning, the validation wheel is reset to the home position. 
 

Macros Pro programs 
Description:  Macros Pro programs will not execute without requiring installation of Macros 
Pro on the system. 
 

Translation Updates:  
Description:  The translation files have been updated. 

 
OMNIC v8.0 
 
New Features 
 
QCheck 

Description: The new QCheck feature allows a user to compare a spectrum to an individual 
reference spectrum or to a set of reference spectra. The analysis is configured with the QCheck 
Setup command found in the Analyze menu and the analysis is performed using the QCheck 
command found in the same menu. 
 

System Performance Verification (SPV)  
Description: The SPV feature provides an integrated monitor to verify instrument 
performance, perform “fit for purpose” tests, and inform the user when tests or maintenance 
have failed or need to be performed. It consists of the Instrument Status monitor, Scheduled 
Maintenance monitor, System Suitability monitor, Performance Verification monitor, and 
ValPro™ monitor (if installed). If any of those items being monitored need to be performed or 
have failed, the System Status indicator changes from green to yellow or red as appropriate. 
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OMNIC Specta 
Description: Added support for sending the selected spectrum in OMNIC to OMNIC Specta™ 
for further analysis. This is accomplished using the Send to OMNIC Specta command in the 
Analyze menu. 

 
Nicolet iS10 

Description: Added support for the Nicolet™ iS™10 spectrometer. 
 

ThermoIQ 
Description: The ThermoIQ utility is now included with OMNIC; previously it was included with 
OMNIC DS. This utility allows you to verify that the files on your computer match the files 
specified by the installer. 

 
Windows Vista support 

Description: OMNIC 8 is compatible with Windows Vista Business edition. However, there are 
two features of OMNIC DS that are not supported in Vista. See the known issues for a 
description of these limitations. 

 
Resolved Issues 
 
OMNIC 
 
Correction Settings in Experiment Setup are offset 

Description:  If you select ATR, H20 or CO2 Correction in Experiment Setup, the software 
actually performs the correction listed one below your selection.   

 
History:  This problem was introduced in OMNIC 7.4. 
 

Apodization and Phase Correction Settings in Spectral header of imported JCAMP files may 
be incorrect 

Description:  The JCAMP file format does not define the apodization function or phase 
correction settings of a spectrum. In previous versions, OMNIC set these values to OMNIC’s 
normal defaults. In OMNIC 8 these values are set to unknown. 

 
History:  This problem was true in all versions of OMNIC that supported JCAMP. 

 
Saving spectra with blank regions to CSV loses X value information. 

Description:  If you saved a spectrum with a blanked region to a CSV file, the X-axis 
information was incorrect for the region above the blanked area. This has been fixed.   

 
History:  This problem was true in all versions of OMNIC that supported saving to CSV. 
 

Bruker® files in %Transmittance scaled incorrectly 
Description:  Files in the Bruker format with data in percent transmittance (%T) were 
incorrectly scaled from zero to one instead of zero to 100. This has been fixed.   

 
History:  This problem was introduced in OMNIC 7.3. 
 

OMNIC32.ini file in Windows directory no longer used 
Description:  Users without Administrator privileges are restricted from writing updates to the 
Windows\OMNIC32.ini file in most Windows environments. OMNIC has changed to writing 
shared state information to the file OmnicSettings.ini in the OMNIC data directory (usually 
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C:\My Documents\OMNIC). This change was necessary to make OMNIC function under 
Windows Vista but was also a problem for some Windows XP environments. 

 
History:  This file had been used since OMNIC 1. 
 
 

Report notebooks become corrupted when too many reports are added 
Description:  Report notebooks with a very large number of reports were getting corrupted and 
the reports could not be read/displayed. The number of reports that caused this problem varied 
depending on how many items were in each report. The incidences of corrupt notebooks that 
were reported held over 10,000 reports before they were corrupted. The reporting code has 
been changed to detect when an attempt it made to add a report to a notebook that is near the 
limit and display an error message. The user must then create a new notebook to save the 
report. 

 
History:  This problem was introduced in OMNIC 3 when report notebooks were 
introduced. 
 

OMNIC no longer allows spectra from commercial libraries to be saved 
Description:  Some previous versions of OMNIC were allowing spectra extracted from 
commercial libraries to be saved as individual spectral data files (as .spa files, for example). 
The old restriction that prevents this saving has been reinstated.   
 
 

Series 
 
Crash when reopening Rapid Scan series files  

Description:  If a Rapid Scan series file was reopened after the initial collection, the X-axis 
could be reversed and any manipulation of the data could cause OMNIC to crash. This has 
been fixed. 

 
History:  This problem was introduced in OMNIC 7.4. 

 
Sampling Information data and time incorrect for Series data 

Description:  When the option to display the Sampling Information collect time field was turned 
on, the date and time displayed for Series data was not valid. This has been fixed and is now 
correct for new series files as well as previously collected series files. 

 
History:  This problem was introduced in OMNIC 7.3. 
 

Known Issues 
 
OMNIC 
 
Tabbing in Options and Experiment Setup does not move between controls. 

Description:  Pressing the tab key does not move the keyboard focus from one control to the 
next in the Options and Experiment Setup dialog boxes. 

Recommendation:  Use the mouse to move keyboard focus to a control. 

History:  Problem occurred in all previous versions. 
 
960 spectrometer help is not provided. 

Description:  The 960 spectrometer help is no longer included with OMNIC software. 
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History:  960 spectrometer help was removed starting with the OMNIC 8.0 release. 
 

Uninstalling ValPro causes new SPV features of OMNIC to display errors. 
Description:  If you have OMNIC 8 and ValPro installed and then uninstall ValPro, subsequent 
use of the System Suitability and Performance Verification features of SPV will display error 
messages indicating the output files have been tampered with. This is caused by the ValPro 
uninstaller unregistering the component needed to apply and verify digital signatures. 

Workaround:  Open a command prompt (in Vista be sure to use a command prompt with 
Administrator rights) and use the command: 
 
regasm "C:\Program Files\Omnic\Thermo_OMNIC_XML.dll" 
 
which will re-register the component needed for digital signatures. Note the path to this file may 
need to be adjusted depending on where the software was installed.  
 
History:  This problem was introduced with OMNIC 8. 

 
Macros Pro 
 
Macro Panel is no longer included with Macros\Pro 

Description:  Macro Panel is no longer included with Macros\Pro™. Macros can be added to 
the OMNIC toolbar with the Edit Toolbar command. 
 
History: Macro Panel was removed starting with the OMNIC 7.1 release. 

 
Series 
 
TA Instruments TGA file not being read using OMNIC Open TGA Data File command 

Description:  In newer versions of TA Universal Analysis software the file format of the TGA 
data files was modified so they are not read by OMNIC using the instructions provided. In order 
for the file to be read by OMNIC it must be saved using the Export utility from the TA software 
selecting the ANSI character set instead of Unicode. 

History:  This bug affects all versions of OMNIC. 
 
Series 3-D display only shows in black and white 

Description:  With the Radeon x300 or x1300 Pro graphics card, the Series 3D display will not 
show colors. The workaround to get the image to display in color is to adjust the hardware 
acceleration setting for the video card. See the Technical Bulletin TBN# IR3140 for detailed 
instructions on how to do this. This problem can also appear in the Atlµs mapping software. 

History:  This bug affects all 7.x versions of Series. 
 
TA Instruments TGA file not being read using OMNIC Open TGA Data File command 

Description:  In newer versions of TA Universal Analysis software the file format of the TGA 
data files was modified so they are not read by OMNIC using the instructions provided. In order 
for the file to be read by OMNIC, it must be saved using the Export utility from the TA software 
selecting the ANSI character set instead of Unicode. 

History:  This bug affects all versions of OMNIC. 
 

OMNIC DS 
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“Run only OMNIC” feature not supported in Windows Vista 
Description:  The security policy named “When user logs on, run only OMNIC” that can be 
used to prevent selected user groups from having access to the Windows desktop is not 
supported in Windows Vista.  
 
History: This is a limitation of Windows Vista support added for OMNIC 8. 

 
Screen Saver setting from Thermo Security Administrator not supported in Windows Vista 

Description:  The security policy named “Automatically start screen saver after (minutes)” that 
can be used standardize a screen saver time for user groups is not supported in Windows 
Vista.  
 
History: This is a limitation of Windows Vista support added for OMNIC 8. 

 
OMNIC v7.4.1 
 
Resolved Issues 
 
International (Non-English) Installation 
Some international versions of the Windows operating system have translated Administrator 
strings that cause a failure when trying to install the OMNIC 7.4 software.  
 
OMNIC v7.4 
 
New Features 
Branding changes 

Description: Changes have been made to the about box, splash screen, program icons and 
folder names to reflect the company brand name change to Thermo Scientific. The about box 
has changed to show the versions from the Windows Installer information rather than the 
version resources of the actual DLL/EXE files. 

 
Help Format Change 

Description: The entire OMNIC help system has been changed to use the “Compiled HTML” 
help now provided with Windows. There have been some minor changes to the help 
functionality with this change.  For example, right clicking in a spectral window no longer brings 
up a help window. This change also eliminates problems with .GID files used by the old help 
system. The old help system tried to update these .GID files as the help file was navigated, but 
would sometimes display error messages if the user did not have sufficient privileges to update 
them. If the .GID files did get updated, the modification dates would no longer match what was 
expected by the IQ tool. These issues are resolved with the new help system. 

 
Experiment Filename added to list of experiments 

Description: The dropdown list of experiments has been enhanced to include the filename of 
the experiment. This helps eliminate confusion when there is more than one experiment with 
the same title. 
 

Automatic Atmospheric Suppression improvements 
Description: Additions were made the Atmospheric Correction feature to improve its 
performance.  This included algorithm changes and an expanded calibration model. 

 
Limit on zero fill options with high resolution data 

Description: A limit on the levels of zero fill the Reprocess feature allowed on high resolution 
data has been removed.  This limit was only needed in 16 bit Windows, but it was left in when 
the transition to 32 bit Windows was made.  Two levels of zero fill are now supported. 
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Additional Jasco file types now recognized 

Description: Jasco files with a newer binary file type indicator are now read by OMNIC. 
 

 
Resolved Issues 
 
OMNIC 
 
Report Notebook spectra all shown in red 

Description:  Reports added to notebooks with versions earlier than OMNIC 7.3 would have 
spectra all displayed as red when viewed with OMNIC 7.3. This has been changed so only the 
selected spectrum is displayed in red.   

 
History:  This problem was introduced in OMNIC 7.3 
 

Autosave Base Names 
Description: In the Collect tab of Experiment Setup, the drop down list for the Base name in the File 
Handling box has failed to show the Auto save base names previously used. This has been corrected. 
 
History:  This problem was introduced in OMNIC 7.3 

 
Incorrect error message when saving to full disk 

Description: OMNIC was giving an error message that indicated the target file was write 
protected if a save was attempted to a disk drive that did not have sufficient free space for the 
save to succeed.  This has been fixed so the error message indicates there is not enough 
space available. 
 
History:  This problem occurred in all versions at least back to OMNIC 5. 
 

Interferograms now attached to reprocessed spectra 
Description: When some spectra with saved interferograms were reprocessed, the saved 
interferograms were not attached to the new result spectrum. This has been fixed so copies of 
the saved interferograms are attached to the newly created result spectrum. 
 
History:  This problem occurred in all versions of OMNIC. 
 

Saving data using filenames that include Kanji characters fail 
Description: OMNIC was not correctly handling filenames that contained some Kanji 
characters. This has been fixed, but requires a system that is running in Japanese. 
 
History:  This problem occurred in all versions of OMNIC. 
 

Derivative command fails from macro if system is language is Japanese 
Description: The derivative command could fail from a macro if the system was running in 
Japanese.  This has been fixed. 
 
History:  This problem occurred in all versions of OMNIC. 
 

QC Compare results not available in Macros Basic 
Description: The results of a QC Compare operation were not made available in Macros 
Basic. This has been fixed. 
 
History:  This problem occurred in all versions of OMNIC since OMNIC 3. 
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Library Converter now allows output to be put in same directory as input 

Description: The Library converter program would generate errors if the output library was 
written to the same directory as the input file.  This restriction has been removed. 
 
History:  This problem occurred in the LibConverter provided with OMNIC 7.3 
 

Data from some GRAMS format libraries scaled incorrectly by Library Converter 
Description: The data from some GRAMS format libraries was being scaled from 0 to 256 
instead of from 0 to 1.0. This has been fixed 
 
History:  This problem occurred in the LibConverter provided with OMNIC 7.3 
 

Data that cross zero on X Axis may crash Find Peaks 
Description: Spectra with data that spanned zero on the X Axis could cause Find Peaks to 
crash. This has been fixed 
 
History:  This problem occurred in all versions of OMNIC since OMNIC 3. 
 

Paste operation fails on newly created window 
Description: When a paste was done into a newly created window, the focus was on the 
disabled title control rather than on the spectral display, so the paste operation failed.  This was 
fixed by programmatically setting the focus on the spectral window. 
 
History:  This problem occurred in all versions of OMNIC since OMNIC 7. 
 

Autosave sequence number does not always increment from a macro 
Description: Collects done in a macro would sometimes overwrite previous collects because 
the autosave sequence number was not incremented. This only failed from macro collects and 
has now been fixed. 
 
History:  This problem was introduced in OMNIC 7.2 

 
Message displayed indicating intermediate collect results would not be displayed 

Description: Collects of high resolution data (0.125 cm-1) would display a message indicating 
the result would not be displayed until the entire collect was complete, but the intermediate 
results would in fact get displayed.  This message has been removed. 
 
History:  This problem was introduced in OMNIC 5 
 

Bench and Diagnostic Tabs of Experiment Setup don't center peak 
Description: When changes were made in Experiment Setup that caused the collect used to 
populate the interferogram display to change sample spacing, the region of the interferogram 
displayed was not adjusted to focus on the same features.  This would usually cause the peak 
to be outside of the display region. This has been changed so the displayed region is adjusted 
for sample spacing changes. 
 
History:  This problem was introduced in OMNIC 4 
 

File Open dialog locks up opening some Mattson files 
Description: OMNIC would lockup when trying to read some files in the Mattson WinFirst 
format.  This happened on files that had text annotations.  This has been fixed so the files read 
correctly. 
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History:  This problem was introduced in OMNIC 6 
 

Pasting Search results into Log file gives garbled RTF 
Description: If a copy was done from an OMNIC window that produced tabular results and 
then the table was pasted into OMNIC's log file, the table header would be garbled.  This was 
fixed by using spaces instead of tabs in the all of OMNIC's table headers. 
 
History:  This problem was introduced in OMNIC 7.2 

 
Floating-Point overflow when expanding interferogram display in Experiment Setup 

Description: A floating-point overflow would sometimes occur when expanding the 
interferogram display on the Bench tab of Experiment Setup, causing an error message to 
appear that forced the user to close OMNIC. This has been fixed. 
 
History:  This problem was introduced in OMNIC 7 

 
Raman menu shown twice 

Description: If OMNIC had trouble communicating with the instrument at startup, but then was 
able to establish good communications, the Raman menu would end of being added to the top 
level menu twice.  Some of the items in the two menus would then be enabled/disabled at the 
wrong times.  This has been fixed. 
 
History:  This problem was introduced in OMNIC 6.2 
 

Collect Sample with region selected stops update 
Description: In the data collect window, if the region tool was used to define a region, the 
remainder of the collect would be discarded and the spectrum on display at the time the region 
was defined would be used as the final result.  This was true even if the region was defined 
while the background single beam was being collected. This has been fixed. 
 
History:  This problem was introduced in OMNIC 7.3 
 

Known Issues 
 
OMNIC 
 
Uninstalling OMNIC 7.x on a system that was upgraded from OMNIC 6.1a 

Description:  If you install OMNIC 7.x over a OMNIC 6.1a installation and then try to uninstall 
OMNIC 7.x using either the Uninstaller on the OMNIC 7.x CD or from Add/Remove programs, 
the OMNIC exe’s and dlls are not removed. The reason is that OMNIC 6.1a was not uninstalled 
before OMNIC 7.x was installed. To uninstall v6.1a, run the uninstaller in the /uninstall folder. 
 
History: This behavior was introduced with OMNIC 7.0. 
 

Tabbing in Options and Experiment Setup does not move between controls. 
Description:  Pressing the tab key does not move the keyboard focus from one control to the 
next in the Options and Experiment Setup dialogs. 

Recommendation:  Use the mouse to move keyboard focus to a control. 

History:  Problem occurred in all previous versions. 
 
Macros Pro 
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Macro Panel is no longer included with Macros\Pro 
Description:  Macro Panel is no longer included with Macros\Pro™. Macros can be added to 
the OMNIC toolbar with the Edit Toolbar command. 
 
History: Macro Panel was removed starting with the OMNIC 7.1 release. 

 
Series 
 
TA Instruments TGA file not being read using OMNIC Open TGA Data File command 

Description:  In newer versions of TA Universal Analysis software the file format of the TGA 
data files was modified so they are not read by OMNIC using the instructions provided. In order 
for the file to be read by OMNIC it must be saved using the Export utility from the TA software 
selecting the ANSI character set instead of Unicode. 

History:  This bug affects all versions of OMNIC 
 
Series 3D display only shows in black and white 

Description:  With the Radeon x300 or x1300 Pro graphics card, the Series 3D display will 
not show colors The workaround to get the image to display in color is to adjust the hardware 
acceleration setting for the video card. See the Technical Bulletin TBN# IR3140 for detailed 
instructions on how to do this.  This problem can also appear in the Atlµs mapping software. 

History:  This bug affects all 7.x versions of Series. 
 
 
OMNIC v7.3 Service Pack 1 (SP1) 
 
New Features 
 
Change to version numbers shown in About box 

Description: A change to the approach used to deliver maintenance software releases for 
OMNIC related products resulted in a change to the information shown in the About OMNIC 
box in the Help menu. Maintenance releases for OMNIC related products are being issued as 
Service Packs that bundle files for all products that have been changed. Only the specific files 
that have changed are updated by the new service pack installation process. There will no 
longer be maintenance releases of individual components, such as OMNIC Search. Because 
of this, the third component of the version number (such as the ‘a’ in 7.2a) is no longer used. 
Instead, the latest service pack (which applies to all components) is shown near the top of the 
About box. 
 
It should be noted that the Service Pack installation requires OMNIC 7.3 to be installed on the 
computer. 

 
Support of the Nicolet 8700 (USB version) 

Description: Support has been added for the USB version of the Nicolet™ 8700 
spectrometer. This includes the extension of the PM modulation amplitude to 4.5 lambdas 
and three enhancements of step-scan time-resolved data collection: The optional use of an 
additional input (Sync), a shorter (1 microsecond) minimum sampling interval when using the 
spectrometer digitizer, and the ability to use multiple triggers per step when using the 
spectrometer digitizer. 

 
New correlation options avoid shifting first scan of collect 

Description:  Two new correlation options were added that are available only by setting the 
DDE parameter “Collect Correlation” to “NoPeakShift” or “NoShiftSimple”. These settings 
cause OMNIC to assume the instrument positioned the peak at the exact location requested for 
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the first scan and do not shift the scan. All previously existing correlation options shift the first 
scan so the largest peak (in absolute value) is located at the requested position. The 
“NoPeakShift” option does not do any correlation on subsequent scans, while the 
“NoShiftSimple” option still does simple correlation on subsequent scans.  
 
This was done to provide a work around for unusual collect conditions where the ZPD location 
cannot be inferred from the largest peak. 

 
Resolved Issues 
 
OMNIC 
 
Smart Accessories not recognized in some circumstances on Nicolet 380 and x700  

Description:  OMNIC was not responding to insertion and removal of Smart Accessories™ if 
the instrument had not been used to collect data for more than 40 minutes. A change was made 
so the instrument always responds to smart accessory changes if OMNIC is running. If OMNIC 
is not running, the instrument will still go into a “rest mode,” but starting OMNIC will 
automatically take the instrument out of “rest mode.” 

 
History:  This problem was introduced in OMNIC 7.3 

 
Nicolet 6700 with Dual Channel option does not collect correctly  

Description:  OMNIC 7.3 has reversed the A and B channels on Nicolet 6700 Dual Channel 
systems. Channel B on these systems is suppose to be the BNC mounted in the baseplate to 
the right of the sample compartment. When OMNIC 7.3 is loaded, this becomes Channel A. 
Then when a Dual Channel PEM collect is made the spectral data that is automatically ratioed 
will be upside down. This has been fixed. 

 
History:  This problem was introduced in OMNIC 7.3 

 
Spectral Header information not correctly extracted from user libraries  

Description:  If a spectrum is added to a user library created with OMNIC 6.0 or newer, the 
header information is preserved in the library and can be viewed if the spectrum is extracted 
from the library. However, a bug in extracting the spectrum from the library was causing this 
header information to be lost. Because of this, using a spectrum extracted from a user library as 
input to the “Match Spectrum Settings” command on the Collect menu would not result in the 
settings being set to match those used to collect the library spectrum. This has been fixed so 
that the correct header information is extracted from user libraries. 

 
History:  This problem was introduced in OMNIC 7.2 

 
Check Desiccant button not available for Nicolet 380 systems 

Description:  The Check Desiccant button on that is suppose to appear on the Diagnostic tab 
of Experiment setup was not present on Nicolet 380 systems. This has been changed so the 
button appears and functions.  

 
History:  This bug was introduced in OMNIC 7.1 when support was added for the Nicolet 
380.   

 
Align results in flat line interferogram on 460 and ECO 1000 

Description:  On some 460 and ECO™ 1000 systems, using the Align feature on the 
Diagnostic tab of Experiment Setup would appear to work correctly, but at the very end of the 
Align, the interferogram would change to a flat line. A Reset of the bench would restore correct 
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scanning operation. A driver change was made to add a small delay (10 milliseconds) to the 
end of the Align operation to avoid this problem.  

 
History:  This bug was introduced in OMNIC 7.0 

 
Polarizer wheel does not move to zero on a Nicolet 8700  

Description:  A bug was found in the Nicolet 8700 PCI driver which prevented the polarizer 
wheel from moving to zero if the attenuation wheel was at zero. This has been fixed 

 
History:  This bug was introduced in OMNIC 7.3 
  

Company Logo change on EZ OMNIC Splash Screen 
Description:  The company logo on the EZ OMNIC splash screen was changed from the 
Thermo Nicolet logo to the Thermo Electron logo. This change was missed when the OMNIC 
splash screen changes for version 7.0. 

History:  This bug was introduced in OMNIC 7.0 
 
Find Peaks locks up if spectrum X Axis crosses zero 

Description:  The Find Peaks operation on the Analyze menu may cause OMNIC to lock up if 
the X Axis covers a range of both positive and negative values. This has been fixed. A work 
around that avoids this lock up is to manually add a piece of annotation using the text tool prior 
to doing the Find Peaks. 

History:  This bug was introduced in OMNIC 7.3 
 
Macros Basic 
 
Macros Basic problems with comma for decimal point 

Description:  Macros Basic was not handling floating point numbers correctly if the system 
was set to use the comma as a decimal point character. This bug has been fixed. 

History:  This bug has existed since at least OMNIC 6.2. 
 
Some Macros saved in Chinese cannot be reopened 

Description:  Some Macros Basic macros saved on systems using Chinese as the system 
language could not be reopened. This has been fixed. 

History:  This bug was introduced in OMNIC 7.3 
 
Series 
 
Incorrect date/time shown for Rapid Scan data. 

Description:  Data collected with Rapid Scan show incorrect date/time in the Series 
Information window. This is for the "collected" date in the second line and also for the "data 
processing" section in the history. The year shows up as 2036 and the month/date appear are 
arbitrary. This has been fixed. 

History:  This bug was introduced in OMNIC 7.3 
 
Rapid Scan for 380 uses wrong Settle time  

Description:  The settle time used for Rapid Scan runs on a 380 was too short causing poor 
quality data to be collected. The settle time was changed from 2 milliseconds to 200 
milliseconds for the 380. 

History:  This bug was introduced in OMNIC 7.3 
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Using more than three Quant components in a Series run causes problems  

Description:  If more than three quant components were selected for profiles using a selected 
quant method when collecting Series data, the Y Axis labels of the profiles could be displayed 
incorrectly and crashes could occur. This has been fixed. 

History:  This bug was introduced in OMNIC 7.3 
 
Series window can now be closed from DDE without prompt to save data  

Description:  The CloseWindow DDE command can be issued with the argument “Yes” to 
save changes to data automatically without prompting the user (that is, “CloseWindow Yes”). 
The Series window now recognizes this argument and will close without a prompt if it is 
present. This allows a Series run to be stopped before is completes by using the two 
commands “StopCollect” and “CloseWindow Yes”. 

History:  This bug was introduced in OMNIC 7.3 because Series data is no longer written 
to disk as operations are performed. 

 
GC temperatures not sent to instrument when changed in Experiment Setup  

Description:  Changes made to the GC flow cell and transfer line temperatures were not being 
sent to the instrument when they were changed in Experiment Setup. This has been fixed. 

History:  This bug was introduced in OMNIC 7.3 
 
Rapid Scan on 8700 PCI misses scans 

Description:  Rapid Scan data collected on an 8700 PCI would have gaps where scans were 
missed if Smart Accessory polling was not manually turned off during the run. This was fixed by 
automatically turning off polling of Smart Accessories during a Rapid Scan run for 8700 PCI 
instruments and restoring the previous polling state at the end of the run.  

History:  This bug was introduced in OMNIC 7.3 
 
Timing of Series collect with external trigger starts before trigger  

Description:  The duration of a Series collect started with an external trigger could be shorter 
than expected because the collect timer was being started before the trigger occurred. This has 
been fixed so the collect time does not start until the trigger occurs.  

History:  This bug was introduced in OMNIC 7.3 
 
Generation of CNC file for profiles created post analysis  

Description:  The concentration output text file (CNC) would not get generated when creating 
a profile on an existing Series data file. This has been fixed so the file now gets generated in 
this mode. 

History:  This bug was introduced in OMNIC 7.3 
 
Known Issues 
 
OMNIC 
 
Uninstalling OMNIC 7.x on a system that was upgraded from OMNIC 6.1a 

Description:  If you install OMNIC 7.x over a OMNIC 6.1a installation and then try to uninstall 
OMNIC 7.x using either the Uninstaller on the OMNIC 7.x CD or from Add/Remove programs, 
the OMNIC exe’s and dlls are not removed. The reason is that OMNIC 6.1a was not uninstalled 
before OMNIC 7.x was installed. To uninstall v6.1a, run the uninstaller in the /uninstall folder. 
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History: This behavior was introduced with OMNIC 7.0. 
 

Tabbing in Options and Experiment Setup does not move between controls. 
Description:  Pressing the tab key does not move the keyboard focus from one control to the 
next in the Options and Experiment Setup dialogs. 

Recommendation:  Use the mouse to move keyboard focus to a control. 

History:  Problem occurred in all previous versions. 
 
Macros Pro 
 
Macro Panel is no longer included with Macros\Pro 

Description:  Macro Panel is no longer included with Macros\Pro™. Macros can be added to 
the OMNIC toolbar with the Edit Toolbar command. 
 
History: Macro Panel was removed starting with the OMNIC 7.1 release. 

 
Series 
 
TA Instruments TGA file not being read using OMNIC Open TGA Data File command 

Description:  In newer versions of TA Universal Analysis software the file format of the TGA 
data files was modified so they are not read by OMNIC using the instructions provided. In order 
for the file to be read by OMNIC it must be saved using the Export utility from the TA software 
selecting the ANSI character set instead of Unicode. 

History:  This bug was affects all versions of OMNIC 
 
OMNIC DS Data Security 
 
Require Signature When Saving Spectrum and OMNIC for Almega 

Description:  If OMNIC DS Data Security is installed on your system, the Require Signature 
When Saving Spectrum policy should be disabled during instrument calibration and 
when smart background data are due to be collected so that the collections will not be 
interrupted by requests for digital signatures. Smart background data are collected during the 
first ~40 hours of instrument inactivity after OMNIC for Almega™ 7.3 is installed and 
periodically after that based on the setting of the Maximum smart background age control in the 
Calibrate Instrument dialog. 

 
OMNIC v7.3 
 
New Features 
 
OMNIC 
 
Added capability to read Bruker and Jasco spectral files 

Description:  OMNIC can now open and display Bruker [.0-9]* and Jasco [*.JWS] spectral data 
files. 
 
History:  This is an enhancement for 7.3   
 

Conversion of PerkinElmer, Bruker, GRAMS/Spectral ID & Sadtler SearchMaster libraries 
Description:  A new application titled “Library Converter” has been developed to convert 
PerkinElmer® Spectrum, Bruker OPUS®, GRAMS/Spectral IDTM and SadtlerTM 
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SearchMasterTM user libraries to OMNIC format. The converted libraries can then be used in 
OMNIC for library searching and with the Library Manager feature. 
 
History:  This is an enhancement for 7.3 

 
New interactive Kramers-Kronig correction  

Description:  A new processing function has been added which allows the user to convert 
specular reflectance data with a Kramers-Kronig correction and either normalize the result to 1 
(one) Absorbance unit or 1 (one) micrometer. The user can also choose to have the N-index 
and/or the K-index spectrum appear with the result. 
 
History:  This is an enhancement for 7.3   

 
Ability to set the parameters for automatic baseline 

Description:  The polynomial order and number of iterations for the automatic baseline 
function can be set in the Edit/Options/Process Tab. 
 
History:  This is an enhancement for 7.3   

 
Added the ability to apply a linearization method to photoacoustic data 

Description:  A new processing function titled “PAS Linearize” has been added that will apply 
the linearization method of R.O. Carter III, Applied Spectroscopy, 46, 219, 1992) to the data. 
This enhances the infrared signal at the sample surface and improves quantitative linearity. 
 
History:  This is an enhancement for 7.3  
 

Titles of the spectra in the search list are now displayed in overlay mode 
Description:  In previous versions, titles for the spectra in the search list were only displayed if 
the spectra were stacked. Titles are now also displayed if the spectra are in overlay mode. 

 
History:  This is an enhancement for 7.3 
 

Added the ability to include the name of a notebook in a report 
Description:  Previously, a field did not exist to add the name of a notebook to a report. This 
field has now been added. 

 
History:  This is an enhancement in 7.3 

 
Clipboard button added to Search Results window 

Description:  A clipboard button was added to the Search Results window that copies the hit 
list as a text table as well as the graphical display of the search results. Users can use “Paste 
Special” in most programs, such as MS Word, to select the format of data they want to paste. 

 
History:  This is an enhancement in 7.3 

 
Tabular data written to Clipboard as RTF 

Description:  Many places in OMNIC that write tabular data to the clipboard were changed to 
write the data as an RTF table as well as the previously supported unformatted text. Users can 
use “Paste Special” in most programs, such as MS Word, to select the format of data they want 
to paste. Pasting RTF tables can simplify formatting of the information in external documents. 
RTF tables are now produced for Find Peaks, Peak Resolve, Search Results, and Annotations,  

 
History:  This is an enhancement in 7.3 
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OMNIC can control Antaris model spectrometers  

Description:  OMNIC can now be used to control the Antaris and Antaris IGS spectrometers. 
 
History:  This is an enhancement for 7.3   
 

Series 
 
Series data collect has been updated 

Description:  Setting up a series data collection is no longer done through the Series menu; it 
has been fully integrated into OMNIC’s Experiment Setup dialog. If Series is installed on your 
system, a new tab titles “Series” will appear in the Experiment Setup dialog. The previous 
capabilities of configuring a series data collection are still available. Additionally, new 
functionality has been added to setting up a series data collection including the ability to set 
collect data for a specific period of time, delay (or suspend) collect data during a specific time 
period, collect data until a specified intensity value is attained, or delay (or suspend) data 
collection until a specific intensity value is reached. The user can also set the Y-axis range for 
the series data collection. 
 
History:  This is an enhancement for 7.3  
 

Series supports FT-Raman and dispersive Raman spectrometers 
Description:  Series data collection can now be used with FT-Raman and AlmegaTM 
spectrometers.   
 
History:  This is an enhancement for 7.3 

 
Opening and saving series data files has been updated 

Description:  Opening and saving series files is now done through the OMNIC File menu 
Open, Save, and Save As items. 
 
History:  This is an enhancement for 7.3  
   

Series 3D display features has been enhanced and updated 
Description:  Displaying a series file with the “Show Series 3D window” menu item has been 
completely redone. A new interactive 3D display is available that allows the user to change the 
viewing angle of the image with the mouse. An enhanced 2-D contour plot has been added. A 
color bar has been added to allow the user to change the color palette used in the 2D and 3D 
images to better differentiate differences in the series data file. Additionally, the user can view 
the spectra and/or profiles on the same screen. The four panes are interconnected so that 
selecting a point or spectrum on one pane, updates the other panes correspondingly. 
Right-click pop-up menus are connected to each pane for quick access to common features of 
that pane. 
 
History:  This is an enhancement for 7.3  
 

Enhanced display options for series data profiles 
Description:  Users have the option to set up to 10 profiles with each series data collect. 
Previously, the limit was 3 (three). Profiles can be displayed in either overlay or stack mode. 
Through the right-mouse pop-up menu, users can choose to copy individual or all profiles to an 
OMNIC spectral window. A similar copy and paste functionality has been added for spectra.  
 
History:  This is an enhancement for 7.3  
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Processing of Series files is integrated into OMNIC menus 

Description:  Users can now use the Process menu to apply relevant processing functions 
(absorbance, transmittance, other conversions, reprocessing (with saved interferograms), 
automatic baseline correct, other corrections, blank, straight line, subtract, automatic region 
subtract, smoothing, derivative and multiply). In previous releases, these functions where 
applied through the Apply Function menu item in the Series menu. 
 
History:  This is an enhancement for 7.3  
 

Searching of a spectrum from a series data collect 
Description:  Users can search the selected the spectrum in the series window. There is no 
longer a need to first copy the spectrum to an OMNIC spectral window.  
 
History:  This is an enhancement for 7.3  
 

Saving of intermediate data during a series collect 
Description:  During a series data collect, data is always saved to disk after every collect cycle 
in order to prevent data loss in case of an error or power failure.   
 
History:  This is an enhancement for 7.3  
 

Ability to use basis vectors from a saved file 
Description:  Users have the option to use basis vectors from a specified file versus collecting 
them at the start of a series collection. Also, the basis vectors can be used as the background 
rather than collecting a separate background. This can speed up the time of the series data 
collection.   
 
History:  This is an enhancement for 7.3  
 

Interferograms can be saved during a series collection 
Description:  Users have the option to save the interferograms along with the data in a series 
collection. Interferograms must be saved if the user desires to reprocess the series data set. 
 
History:  This is an enhancement for 7.3  
 

Split series supports long file names 
Description:  Users use up to 64 characters for the names of the individual files created when 
splitting a series file. In previous versions, the limit was 4 characters.  
 
History:  This is an enhancement for 7.3  
 

Series features supported by Thermo Security Administration 
Description:  Access to the Series features and policies for series spectral data files can now 
be controlled with the Thermo Security Administration application if needed by the user to 
comply with FDA regulations such as 21 CFR Part 11.  
 
History:  This is an enhancement for 7.3  

 
EZ OMNIC 
 
Automatic Atmospheric Suppression now supported in EZ OMNIC 

Description:  Atmospheric suppression can now be used in EZ OMNIC to automatically 
remove water vapor and CO2 interferences during spectral data collection. 
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History:  This is an enhancement for 7.3  

 
Advanced ATR now available 

Description:  Users can now apply the Advanced ATR Correction processing feature. 
 
History:  This is an enhancement for 7.3  

 
EZ OMNIC now supported by DS and Thermo Security Administration 

Description:  The ability to digitally sign spectral data files in EZ OMNIC and control EZ 
OMNIC through Thermo Security Administration has been added. Note it cannot be used to 
sign library files in EZ OMNIC.  
 
History:  This is an enhancement for 7.3  

 
Print/Preview Report is available  

Description:  Users now have the ability to print and preview reports with EZ OMNIC. A variety 
of templates are provided for including the spectral data, search results, peak tables, and data 
collection information together in a single document which can then be printed. 
 
History:  This is an enhancement for 7.3  
  

Software IQ 
 
New application provided with OMNIC DS to verify software installation 

Description:  A new application is available with OMNIC DS to verify that the correct versions 
of files are installed and that the files are installed in the correct folders. A report in HTML 
format is generated that lists all of the installed files and notes any discrepancies from the 
expected result. This replaces the written checklist of files previously provided for OMNIC and 
OMNIC DS Software IQ.  
 
History:  This is an enhancement for 7.3  

 
Resolved Issues 
 
OMNIC 
 
Selected spectra not retained when added to a notebook 

Description:  If multiple spectra existed in a spectral window when the data was added to a 
notebook, which spectrum was the selected spectrum was not retained in the notebook itself. 
This has been changed so that the selected spectrum from the spectral window appears as the 
selected spectrum when the report is viewed in the notebook. 

 
History:  This has existed since lab notebook functionality was added with OMNIC 4.0 

 
Title of a newly created notebook was incorrect when the notebook was viewed 

Description:  Create a new notebook. Use the View Notebook command and choose a 
different notebook to view. From viewing notebook window, choose the newly created 
notebook. The title displayed when the new notebook appeared was that of the previously 
viewed notebook. This has been changed to show the title of the currently selected notebook. 

 
History:  This has existed since lab notebook functionality was added with OMNIC 4.0 
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Displayed data collection information is not added to the report in a notebook 
Description:  If the data collection date and time were displayed in the OMNIC spectral window 
and the data was added to a notebook, the collection date and time did not appear in the 
spectral window in the notebook report. This had been changed so that the displayed collection 
information is displayed in the report notebook if it appears in the spectral window. 

 
History:  This has existed since lab notebook functionality was added with OMNIC 4.0 

 
The base file name for autosave has been expanded to 32 characters 

Description:  In previous versions of OMNIC, the length of the base file name for autosave was 
limited to 4 characters. This has been increased to support up to 32 characters. 

 
History:  This has existed in all previous versions of OMNIC 

 
The down arrow control for viewing the list of spectra disappeared after hiding a spectrum 

Description:  On some systems, the down arrow next to the list for the spectra in the OMNIC 
window disappeared after hiding a spectrum. This prevented the user from “unhiding” the 
hidden spectra. This has been fixed. 

 
History:  This has existed on some systems since OMNIC 6.1a 

 
Cannot not label peaks or pick peaks if spectra are in wavelength 

Description:  Peaks could not be annotated correctly if the x-axis was in wavelength. This has 
been fixed to show the correct annotation for the selected x-axis. 

 
History:  This has existed in all previous versions of OMNIC 

 
Could not print out entire list of QC Compare libraries if greater than one page 

Description:  Printing out a listing of all QC Compare libraries would stop after the first page. 
This has been fixed to print out all QC Compare libraries using multiple pages if needed. 

 
History:  This has existed since OMNIC 4.0 

 
Auto file naming spectra in a macro could give odd file names 

Description:  If the base file name for autosaving spectra in a macro ended in a number, the 
names would not sequence correctly. This has been fixed to allow base file names to end in 
alphabetical or numeric characters. 

 
History:  This has existed in all previous versions of OMNIC 
 

Selecting a new initial library directory in Options was not seen in Library Setup 
Description:  If a different Initial User Library directory was set in the Edit/Options/File dialog, 
the directory didn’t appear in the Library Directories box in Library Setup. To see it, one had to 
delete one or more of the listed directories from the box. This has been fixed to include the 
initial user library directory in the list of Library Directories in Library Setup. 

 
History:  This has existed since OMNIC 6.1 
 

Y-axis annotations are fixed at 3 decimal points 
Description:  The number of decimal points use for Y-axis annotations is now controlled by the 
number of decimal points option in the Options dialog. 

 
History:  This has existed in all previous versions of OMNIC 
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If region search is used, the regions are not displayed in the Search Result window 
Description:  Search regions were not displayed on the Search Result window if they were 
enabled. OMNIC has been changed to display the search regions on the results window. 

 
History:  This has existed since OMNIC 7.0 
 

Copying and pasting an OMNIC window with a selected area does not display the region 
correctly in MS Word 

Description:  If a spectral window showing a shaded area is copied and pasted into Microsoft® 
Word, the shaded area extends past the bottom of the y-axis. This has been changed to only 
show the shaded area with the boundaries of the graph. 

 
History:  This has existed since OMNIC 7.0 
 

The options in the bench tab of experiment setup are not properly updated if a Smart 
Accessory is changed 

Description:  If a Smart AccessoryTM change is made when the Bench Tab of Experiment 
Setup is open, the dialog settings are not updated. The Smart Accessory change will cause a 
new experiment file to be loaded, but the new settings are not shown in the Bench tab. Also, the 
live display does not properly show the interferogram. This has been changed to properly 
update the Bench tab settings with the information from the newly loaded experiment file. 

 
History:  This has existed since OMNIC 7.0 
 

If match settings is used in Library Manager to collect a spectrum, it does not follow the 
options set for number of background scans 

Description:  Spectra collected by selecting match settings in Library Manager always 
collected the same number of background scans as sample scans. It ignored whether a 
different number of background scans had been enabled in the Collect tab of Experiment. This 
has been changed to follow the settings in the Collect tab. 

 
History:  This has existed since OMNIC 7.0 
 

Autoblanking regions can cause Advanced Diagnostics tests to fail 
Description:  If autoblanking regions were enabled in the Advanced Tab of Experiment Setup, 
the regions were used during the advanced diagnostics tests. If the region between 2000 and 
100 was blanked, the tests would fail. This has been changed so that advanced diagnostics 
ignores the autoblank regions. 

 
History:  This has existed since OMNIC 7.2 
 

Spectral range for the diamond Smart Orbit gives improper out-of-range warnings 
Description:  The diamond window material range and useful range for the Smart Orbit differ 
and a warning is displayed if the range is set to go below the recommended range of 525 cm-1 
for diamond. This has been changed to allow for the full range of the diamond optics. 

 
History:  This has existed since OMNIC 7.2 
 

Default report template not set at install 
Description:  A default report template was not set up when the software was installed. This 
has been changed to load a default template. 

 
History:  This has existed since OMNIC 7.2 
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When the information produced with the region tool is removed after the region is drawn 
Description:  While the region tool is used to draw an area, it displays information about the 
selected region. The information disappears as soon as the drawing is complete although the 
shaded region remains. This has been changed to show the information with the shaded 
region. 

 
History:  This has existed in all previous versions of OMNIC 
 

Messages of inappropriate parameters in the experiment file do not indicate which 
parameter was incorrect 

Description:  If an experiment file is opened and a parameter from the experiment is not 
appropriate for the current system configuration, a generic error message would appear saying 
an inappropriate parameter was found and not loaded. This has been changed to identify which 
parameter was not appropriate. 

 
History:  This has existed in all previous versions of OMNIC 
 

OMNIC may crash when reprocessing libraries created with OMNIC 6 
Description:  If a version 6 OMNIC library was reprocessed through DDE, OMNIC may crash. 
This was fixed to allow the reprocessing on OMNIC 6 spectra. 

 
History:  This has existed since OMNIC 7.2 
 
 

EZ OMNIC 
 
Selecting an *.spa file in Windows Explorer and double-clicking does not launch EZ OMNIC 

Description:  On systems with only EZ OMNIC installed, the application would not launch if a 
spectral data file was double-clicked in Windows Explorer. This has been fixed. 

 
History:  This has existed since OMNIC 6.1 

 
A default experiment file is not selected during the installation 

Description:  A default experiment file is not set when EZ OMNIC is installed. This has been 
changed to load default.exp when EZ OMNIC is first installed. 

 
History:  This has existed since OMNIC 7.2 

 
Val-Q™ autotester will not run with EZ OMNIC 

Description:  The auto tester program for algorithm verification would not run on EZ OMNIC 
only systems. This has been fixed. 

 
History:  This has existed since OMNIC 7.1 
 

Peak Resolve 
 
Wrong peak may be highlighted when editing peak table 

Description:  After a fit operation, the peak table can be viewed in the Peaks... dialog. It was 
possible for the wrong peak to be highlighted in the graphical window behind the dialog. This 
has been changed so the correct peak is highlighted. 

 
History:  This has existed since OMNIC 7.2 
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Thermo Security Administration 
 
Access to adding a library spectrum to a window is not totally controlled with Thermo 
Security Administration 

Description:  If Thermo Security Administration was used to disable access to the library 
manager “Add to window” button, it only turns it off on the Library tab. The same button on the 
Spectra tab is still enabled. This has been changed so that if access to the Add to Window 
functionality is disabled, it is disabled on both tabs of Library Manager. 

 
History:  This has existed since OMNIC 6.2 

 
Report templates could be overwritten when prevent overwriting files was enabled in 
Thermo Security Administration 

Description:  Even with the policy set to prevent overwriting on files, report templates could be 
overwritten as Save As was enabled with the Edit template feature. This has been changed to 
disable the Save As functionality if prevent overwrite files is enabled. 

 
History:  This has existed since OMNIC 7.1 
 

Thermo Security Administration allows any valid user to log in 
Description:  When the Thermo Security Administration program starts, it prompts for a user 
name and password. However, it accepts any valid username and password rather than just 
the person for the currently logged on user. This has been changed so that only the person 
currently logged on to the computer can log into Thermo Security Administration. 

 
History:  This has existed since OMNIC 7.2 

 
Thermo Security Administration fails to add domain user to policy groups 

Description:  Under some conditions, after a local user account has been added to a policy 
group, all attempts to add domain user accounts will fail. This has been fixed. 

 
History:  This has existed since OMNIC 6.2 
 

Unable to sign files a second time if prevent overwriting is enabled 
Description:  If the Thermo Security Administration program has prevent overwriting of files 
enabled, the user who collected the spectrum or another user will not be able to sign the file 
again. The user will receive the error: "Write denied. The file is read only." This has been 
changed to allow the user to sign the files more than once. 

 
History:  This has existed since OMNIC 7.2 
 

Additional Analyze menus items are being disabled 
Description: If access is denied to everyone for the last entries of the Analyze menu (Quantify, 
Quant Setup, and View Library), "Add to Library" command is also disabled. In addition if the 
permission to access "Add to Library" is removed the "QC compare" function is disabled as 
well. This has been changed to only disable the selected features. 

 
History:  This has existed since OMNIC 7.2 
 

OMNIC v7.2a 
 
Resolved Issues 
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OMNIC 
 
Font used for axis on printed reports very small or very large  

Description:  An intermittent problem with the size of the font used for printing axis in reports 
was fixed. Reports now print with the correct axis font. 

 
History:  This has been a bug since reports were added to OMNIC in version 3.0. 
 

Bitmaps that overlap other fields of report fail to print 
Description:  On some printers, bitmap fields of reports will not print out if they overlap other 
fields. A warning message is now displayed when a report template is saved and there is an 
overlapped bitmap field that may not print on some printers. Users can choose to save the 
template anyway since the report will print correctly on most printers. 

 
History:  This issue is related to printer drivers and could occur in any version of OMNIC 
that includes reporting (version 3.0 and later). 

 
Printing to non-Default printer may use incorrect font size 

Description:  Any printout in OMNIC that was sent to a printer other than the default printer 
would use the wrong size fonts if the selected printer was set for a different DPI than the default 
printer. This is similar to the report printing bug mentioned above, but could affect any printed 
text in OMNIC and was not intermittent on systems configured as described. The problem has 
been fixed by selecting the correct fonts for the printer selected. 

 
History:  This has been a bug in all previous versions of OMNIC. 
 

Username provided to ValPro not correct 
Description:  If OMNIC was not configured for logins (either with OMNIC DS or OMNIC custom 
logins), the username OMNIC provides to ValPro™ was the name entered when OMNIC was 
installed rather than the name of the current user. This results in the ValPro report displaying 
the incorrect username. This has been fixed so that OMNIC now provides the name of the user 
currently logged on to Windows. 

 
History:  This problem was introduced with OMNIC 7.2 and the initial release of the 
ValPro product.   

 
Access Violation when collecting data from a Macros\Basic macro 

Description:  An occasional Access Violation would occur when repeatedly running a 
Macros\Basic™ macro that collected data and the macro was set to “Reset OMNIC parameters 
when macro ends”. This same problem would sometimes cause the spectra to draw with a 
”filled” appearance. The problem has been fixed in this release. 

 
History:  This problem was introduced with OMNIC 7.0 

 
Y Axis label incorrect when importing some Perkin-Elmer files  

Description:  Perkin-Elmer files that used a Y-Axis identifier of “Abs” rather than “A” were 
displayed in OMNIC with a Y-Axis label of “Arbitrary Units”. OMNIC now recognizes these files 
as absorbance and displays the correct Y-Axis label. 

 
History:  This problem has existed in all versions of OMNIC that read Perkin-Elmer files. 
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Access Violation when setting up Atmospheric Correction  

Description:  An access violation would occur when using Experiment Setup to create an 
experiment file that used Atmospheric Correction and a set of collect options not covered by the 
supplied correction standards. The violation occurred when OMNIC tried to generate the new 
standards needed for unusual collect conditions, such as triangular apodization. Most of these 
unusual collect conditions are controlled on the advanced tab of Experiment Setup. This 
problem has been fixed. 

 
History:  This problem was introduced with OMNIC 7.0. 
 

Atmospheric Correction controls disabled in EzOMNIC  
Description:  Atmospheric Correction is not included in EzOMNIC, but some of the controls in 
Options and Experiment Setup that are used to control this feature are still enabled. This has 
been changed so the controls are disabled in EzOMNIC. 

 
History:  This problem was introduced with OMNIC 6.1. 

 
OMNIC DS 
 
Save Group (.SPG) does not generate an event log record 

Description:  The Save Group operation in OMNIC that writes .SPG files was not generating 
an event in the Thermo portion of the Windows Event Log. This has been fixed. 

 
History:  This problem was introduced with OMNIC 6.2. 

 
OMNIC v7.2 
 
New Features 
 
OMNIC 
 
ValPro compatibility 

Description:  Features have been added to OMNIC to support the new ValPro validation 
package. 

 
History:  This is an enhancement for 7.2 

 
OMNIC DS 
 
Individual control of ancillary OMNIC programs launched from OMNIC 

Description:  Access to all of the ancillary programs that can be launched from the OMNIC 
menus can now be controlled individually from the Thermo Security Administration (TSA) 
program. This allows administrators to restrict a given user to launching some ancillary 
programs but not others. For example, a user may be allowed to launch Advanced Diagnostics, 
but not allowed to launch ValPro. In previous versions, the ability to launch all ancillary 
programs, as well as independent programs assigned to toolbars or menu items through Edit 
Toolbar or Edit Menu were controlled by a single access control item in TSA (called “Run 
programs from menu or toolbar” in the “Custom toolbar and menu items” group).  
 
To gain access to these new settings in TSA, the administrator must load the new OMNIC.XML 
file through the “Add Application…” menu item in the File menu of TSA. The OMNIC.XML file is 
located on the root of the OMNIC installation CD in uncompressed format. Loading the new 
version will only add new entries to the TSA database; it will not change any existing settings. 
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The new entries are located in the Access Control group that corresponds to the OMNIC menu 
they appear in. For example, Advanced Diagnostics is in the Collect group and InterpretIR+™ 
is in the Analyze group. 
 
The “Run programs from menu or toolbar” access control item mentioned above is still 
available for controlling access to all independent programs added to the menu or toolbar. 
 
If you are upgrading to version 7.2 of OMNIC DS and do not reload the OMNIC.XML file into 
TSA, all of the ancillary programs will be controlled by the “Deny access to menu items not in 
security database” System Policy since OMNIC now sees each of these as an individual 
command rather than a run command.  

 
History:  This is an enhancement for 7.2 

 
MACROS PRO 
 
Environment variables can be used in arguments  

Description:  OMNIC now expands all environment variables in DDE arguments before 
executing the commands. This also occurs when the commands are passed through the 
OMNIC COM interface. 

 
History:  This is an enhancement for 7.2 

 
New “Locked” mode available for the OmnicMode command  

Description:  The OMNIC Macros Pro DDE command “OmnicMode” now accepts the 
“Locked” keyword to put OMNIC in a mode similar to the “Simple” mode with no menus or 
toolbars, but with the additional constraint that user input is ignored on the active window. This 
prevents the user from changing the active window or boxing within the active window or any 
other similar interactions. However, dialogs that are presented by OMNIC do accept user input. 
This new mode can be used when OMNIC is being driven by an external program or macro to 
prevent users from making unwanted changes to the context OMNIC is using. To switch back 
to the normal mode, use the command “OmnicMode Normal”. 

 
History:  This is an enhancement for 7.2 

 
New “Overscale” command for scaling and aligning spectra  

Description:  A new scaling command has been added that makes it easier to compare 
spectra on a common scale when they have different baselines. The command is called 
"Overscale" and it is similar to doing "FullScale" followed by "CommonScale" and then 
manually dragging the spectra so their baselines coincide. The command can also be used to 
align peaks or midpoints. OverScale takes one argument that indicates what part of the spectra 
should be aligned as shown below. 
 "OverScale Baseline | Peak | Midpoint" 
This command was added for the user interface of a new TQ Analyst version and is available 
as an OMNIC command because of a common codebase. It is not available through the 
OMNIC user interface yet. 

 
History:  This is an enhancement for 7.2 

 
Resolved Issues 
 
OMNIC 
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Correct diagnostic information displayed in OMNIC for a Nicolet 380 instrument 
Description:  The power supply diagnostics dialog available within OMNIC from the Diagnostic 
tab of Experiment setup now shows the correct list of voltages for a NicoletTM 380 instrument. 
These voltages are for +5, +12, -12, +1.2, +2.5, +3.3 and -5 volts. In previous releases, only the 
+5, +12, -12 voltages were displayed. Also, the laser voltage readout has been removed from 
the Laser Diagnostics dialog when used with a 380 since the 380 does not provide this 
information. The laser voltage readout displayed for 380 instruments in previous releases was 
not accurate. 

 
History:  This bug was introduced in OMNIC 7.1 when support was added for the Nicolet 
380.   

 
Automatic atmospheric suppression available with Nicolet 380 instrument 

Description:  The checkbox for turning on automatic atmospheric suppression on the Collect 
tab of Experiment setup is now enabled when using a Nicolet 380 instrument. This allows users 
to perform automatic atmospheric suppression during data collect with a 380 instrument. 

 
History:  This bug was introduced in OMNIC 7.1 when support was added for the Nicolet 
380.   

 
Single-sided interferogram available with Nicolet 380 instrument 

Description:  The check box for specifying single-sided interferograms on the Advanced tab of 
Experiment setup is now enabled when using a Nicolet 380 instrument. 

 
History:  This bug was introduced in OMNIC 7.1 when support was added for the Nicolet 
380.   

 
Verify smart accessory available with Nicolet 380 instrument 

Description:  The button for verifying the Smart Accessory on the Diagnostic tab of Experiment 
Setup is now enabled when using a Nicolet 380 instrument. 

 
History:  This bug was introduced in OMNIC 7.1 when support was added for the Nicolet 
380.   

 
Saving spectra from Search results window  

Description:  Several menu items, including Save As, that were disabled when the Search 
result window was active are now enabled. This allows the Search Result window to be saved 
as a .WMF file.  

 
History:  This bug was introduced in OMNIC 7.0. 

 
Search and QC Compare from Macros Basic do not require user action to proceed  

Description:  OMNIC now correctly supports the Macros\BasicTM feature that allows Search 
and QC compare operations to complete and leave their result window open while the macro 
continues with no user interaction. In 7.0 and 7.1, the macro would not continue until the user 
manually closed the Search or QC Compare window.  

 
History:  This bug was introduced in OMNIC 7.0. 

 
Report fields not displayed when editing templates fixed  

Description:  In some situations, report fields were not being displayed when a template was 
edited. This would only happen if report fields were added and deleted in a specific order. This 
is now fixed.  
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History:  This bug has existed in all versions of OMNIC since 3.0. 

 
Autosave filename in title dropping last character fixed  

Description:  When the feature that allows the title of collected spectra to include the autosave 
filename was used (see the Collect tab of the Options dialog), the last character of the autosave 
prefix was dropped from the title. So if the autosave prefix was set to “abcd” and the sequence 
of collects results in a file being autosaved as “abcd0123.spa”, the title would include 
“abc0123.spa” rather than “abcd0123.spa”. This has been fixed. 

 
History:  This bug has existed in all versions of OMNIC since 4.0. 

 
Spectra not scaled properly when read from GRAMS multifiles 

Description:  When the ability to read GRAMS multifiles was added, the first scale factor in the 
file was used to scale all spectra. This has been changed to the individual scale factors. 

 
History:  This bug was introduced in OMNIC 7.0. 

 
Save Range changed when it should not have in Experiment Setup 

Description:  On the Bench tab of Experiment Setup, if one of the properties lists that affect the 
recommended save range, such as Source or Window Material, is dropped down and then 
collapsed without making a change, the save range would be reset to the recommended range. 
This has been changed so the save range is only reset to the recommended range if one of the 
properties is changed. 

 
History:  This bug was introduced in OMNIC 7.0. 

 
Recommended Save Range not including Window Material when Bench tab first displayed 

Description:  When the Bench tab of Experiment Setup is first displayed, the Window Material 
was not included in the calculation of the recommended save range. This has been fixed. If any 
of the properties affecting save range was changed, the recommended range was calculated 
properly in earlier versions. 

 
History:  This bug was introduced in OMNIC 7.0. 

 
Find Peaks deletes peak labels outside of the region it is applied to 

Description:  The Find Peaks command is supposed to delete all peak labels in the region it is 
applied to before it adds the new labels. In 7.0, this was enhanced to leave annotation that was 
created using the peak height and peak area tools even if they are in the Find Peaks region. 
This change introduced a bug where some peak labels outside of the Find Peaks region were 
deleted by mistake. This has been fixed. 

 
History:  This bug was introduced in OMNIC 7.0. 

 
Preview Collect controls appear in collect window after a resize or change focus 

Description:  When the preview collect feature is used and the collect has progressed past the 
preview, the Start Collection button used to finish preview mode reappears by mistake in place 
of the save controls whenever a resize or focus change occurs on the collect window. This has 
been fixed. 

 
History:  This bug was introduced in OMNIC 4.0. 
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DDE Initiate messages no longer destroy global atoms 
Description:  OMNIC no longer destroys the global atoms used during processing of DDE 
initiate messages. Although destroying these atoms is the correct protocol, some Visual Basic 
programs that process the same DDE initiate messages crash if OMNIC does this. This may 
only be a problem on some versions of Windows. 

 
History:  This bug was introduced in OMNIC 7.0. 

 
Correct Velocities now displayed for Nicolet 380 

Description:  In some circumstances, the wrong list of available velocities would be shown in 
Experiment Setup when used with the Nicolet 380. Several of the slow velocities would be 
missing. This has been fixed. 

 
History:  This bug was introduced in OMNIC 7.1 when support was added for the Nicolet 
380. 

 
Nicolet 380 does not work with the Centaurµs microscope 

Description:  The Nicolet 380 would not collect data from a Centaurµs™ microscope. This has 
been fixed. 

 
History:  This bug was introduced in OMNIC 7.1 when support was added for the Nicolet 
380. 

 
Cannot set Low pass filter on Nicolet 8700 

Description:  The Low pass filter on the advanced tab of Experiment Setup was never enabled 
when used with a Nicolet 8700. This has been fixed. 

 
History:  This bug was introduced in OMNIC 7.1 when support was added for the Nicolet 
8700. 

 
External trigger with a Nicolet Series instrument only works the first time 

Description:  The external trigger option in Series software would only work the first time. This 
was fixed by a driver change. 

 
History:  This bug was introduced in OMNIC 7.0. 

 
MACROS PRO 
 
Export command displays save dialog when it should not 

Description:  When OMNIC DS is installed and "Prevent Overwriting of files" and "Prevent 
changing directories when saving files" policies are turned off in Thermo Security Admin tool, 
the DDE Export command displays the “Save As” dialog even when the destination file does 
not yet exist. This has been fixed. 

 
History:  This bug was introduced in OMNIC 6.2. 

 
OMNIC v7.1a 
 
Resolved Issues 
 
OMNIC 
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OMNIC unstable after leaving Bench tab of Experiment Setup 
Description:  In some cases, if the keyboard focus is on the Sample Compartment row of the 
property grid on the Bench tab of Experiment Setup when a switch to another tab is done (or 
the dialog is closed) OMNIC will become unstable and communications with the instrument 
may be unreliable. One symptom of this is a completely blank tab displayed in Experiment 
Setup. A work around for this problem is to always change the keyboard focus to some row 
other than the Sample Compartment before leaving the Bench tab. This problem has been 
fixed so the work around is no longer needed. 

 
History:  This bug was introduced in OMNIC 7.0.   

 
Detector changes when Sample Compartment list is viewed  

Description:  In some cases, when the Sample Compartment list is dropped down and then 
collapsed without making a change, OMNIC will change the selected detector. The change in 
detector may also cause other fields to change such as the velocity and save range. This 
problem has been fixed. 

 
History:  This problem has existed in versions of OMNIC at least back to 6.0.   

 
OMNIC v7.1 
 
New Features 
 
OMNIC 
 
Peak Resolve. 

Description:  A new Peak Resolve menu item is available in the Analyze menu. Peak Resolve 
models or fits a number of pure peaks to a complex set of overlapping peaks in a sample 
spectrum. A table of the pure peaks is produced that can be printed or copied to the clipboard. 

 
History:  This is an enhancement for 7.1   

 
Faster Control of Nicolet Series Instruments. 

Description:  When controlling a Nicolet Series instrument, OMNIC is no longer required to 
wait for each motor movement to complete before initiating the next operation. OMNIC does 
still wait for all movements to complete before initiating data acquisition. This change results in 
faster startup and more responsive changes in Experiment setup. 

 
History:  This is an enhancement for 7.1   

 
New default configuration file. 

Description:  The default configuration file for OMNIC has been changed. If you have changed 
your default.con file, the OMNIC 7.1 installer will not overwrite the modified file. The changes 
include putting the toolbar across the top, using a smaller font size for annotation and 
prompting for the sample title at the end of sample collects rather than the beginning. 

 
History:  This is an enhancement for 7.1   

 
Support added to Nicolet Series and Nexus drivers for Continuum XL. 

Description:  The Nicolet Series and Nexus™ bench drivers have been enhanced to support 
collecting data from the array detector of the Continuum™ XL. 

 
History:  This is an enhancement for 7.1   
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Environment variables now allowed in Menu and Toolbar paths. 

Description:  Paths to executables and macros assigned to toolbar items or menu items can 
now contain environment variables. The variables will be expanded at the time the item is 
selected by the user. This allows configuration files to be created on one machine and run on 
another where the target files are in a different location, as long as an environment variable 
exists that specifies the location. 

 
History:  This is an enhancement for 7.1   

 
JCAMP-DX Enhancements. 

Description:  Raman spectra saved to JCAMP are now labeled with the ##DATATYPE string 
of RAMAN SPECTRUM instead of INFRARED SPECTRUM as stated in the JCAMP 
specification. Also, the XUNITS field for Raman spectra is now set to 1/CM instead of being left 
blank. The X and Y-axis units can now be set properly when Raman spectra saved with these 
enhancements are read back in. 
 
As a separate issue, JCAMP files with YUNITS of TRANSFLECTANCE and now recognized 
and treated as Transmission spectra. 

 
History:  This is an enhancement for 7.1   

 
More pre-peak data points used for Raman collect above 4 cm-1 resolution. 

Description:  Previous versions used an interferogram peak position of 1024 when Raman 
collects were done at resolution of 2 cm-1 and higher. This has been changed to use the 
maximum number of pre-peak data points (usually 8192) at these higher resolutions. Testing 
has shown this improves the actual achieved resolution of some Raman collects. 

 
History:  This is an enhancement for 7.1   

 
Array Automation 
 
Added ability to skip wells. 

Description: In the Array Collect window, if preview mode has been selected for the collection, 
a button labeled “Skip well” will be displayed during the preview collects. If it is selected, the 
preview collects will stop and the data collection in the current well will be skipped. I.e., it will be 
as if the well had never been selected in the Wells tab. 
 
History:  This is an enhancement for 7.1.   

 
Improvements to the Array: Open Data Set window. 

Description:  There are several new capabilities in the Array: Open Data Set window related to 
the display of more than one spectrum in the window at the bottom. 
 
 If the shift key is held down while a well (or section of an expanded well) is left clicked, the 

spectrum will be added to the window at the bottom instead of replacing the one that is 
there. 

 If a row letter or column number is left clicked, all of the spectra from all of the wells in the 
row or column will be added to the window. 

 Multiple spectra can be selected or deselected in the window by clicking on the spectra with 
the Ctrl key held down (as in an OMNIC window). 
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 The Select All and Clear items in the Edit menu are active as are the corresponding 
<Ctrl/W> and <Ctrl/Delete> accelerators. 

 The Full Scale, Common Scale, Offset Scale, and Display Limits items in the View menu 
are active, and operate on the spectra in the Array: Open Data Set window. 

 All selected spectra are copied to the selected OMNIC window by the Add button. 

 
History:  These are enhancements for 7.1.   

 
Change well selection using arrow keys. 

Description: In the Array: Open Data Set window (and the Collect Array window when the 
display is not in the “Live” mode), a well may be selected (for display) adjacent to the currently 
selected/displayed well by using the arrow keys to move to the well that is to the left or right of 
or above or below the current well. 
 
History:  This is an enhancement for 7.1.   

 
Quant report allows All choice. 

Description: In the Reprocess controls in the Array: Open Data Set window, if a quant method 
is selected as the metric and the Result has more than one Type defined in the quant method 
(e.g., several components in a CLS quant method), the Type dropdown list box will contain an 
additional choice: “All”. If “All” is selected, when the Report button is selected, the spectra in the 
data set will be reanalyzed and the resulting *.csv report file will contain separate columns for 
each of the components in the method. 
 
 
History:  This is an enhancement for 7.1.   

 
Region controls provided for specifying correlation region. 

Description: The Correlation option in the Reprocess controls in the Array: Open Data Set 
window has been modified as follows. If Correlation is selected as the metric, the Region edit 
controls are displayed allowing specification of a region of the spectrum that is to be used for 
the correlation operation. (Previously the entire spectrum was used.) The region tool is active to 
select the region graphically from the displayed spectrum. 
 
History:  This is an enhancement for 7.1.   

 
Peak height ratio and Peak area ratio metrics available in reprocess. 

Description: The Metrics available in the Reprocess controls in the Array: Open Data Set 
window now include “Peak height ratio” and “Peak area ratio”. If either of these is selected, two 
radio buttons labeled “Numerator” and “Denominator” are displayed. When the former is 
selected, the peak or region and baseline edit controls are used to specify the frequencies of 
the peak or region and baseline to be used for the numerator of the ratio. The latter radio button 
allows specification of these frequencies for the denominator of the ratio. 
 
History:  This is an enhancement for 7.1.   

 
Kinetics. 

Description: A Kinetics Setup button has been added to the Methods tab of Array Setup that, if 
selected, displays a Kinetics Setup dialog. This dialog allows the user to specify how frequently 
the entire plate is to be measured and how many times it is to be measured. 
 
History:  This is an enhancement for 7.1.   
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New Array menu items. 

Description: The Array menu has been expanded to include several new items that are active 
when an Array: Open Data Set window is displayed. 
 
 If the Show Array Information item is selected, a Collection and Processing Information 

window is displayed containing these data for the data set. 

 If the Change Title item is selected, the current title of the data set is displayed in a dialog 
and a new title can be entered. 

 If the Save Array As item is selected, a Save As dialog is displayed, allowing specification 
of a new file name into which a copy of the current data set will be saved. (This is useful if 
the Apply Function operation is to be done on a data set, and the original data need to be 
retained.) 

 If the Apply Function item is selected, a dialog is displayed allowing selection of a function 
to be applied to the spectra in the data set. Depending on the function selected, one or 
more other controls may appear in the window to specify the parameters for the function. 
E.g., if Smooth is selected, the number of smooth points must be entered. 

 If the Split Array item is selected, a dialog is displayed allowing selection of a range of wells 
whose spectra will be extracted from the current data set and stored in separately named 
.spa files.  

 
History:  These are enhancements for 7.1.   

 
MACROS PRO 
 
Replaceable collect prompts. 

Description: Two new strings have been added that control the text displayed in the prepare 
for sample and prepare for background dialogs that appear during data collects. The new DDE 
parameters are "Custom SamplePrompt" and "Custom BackgroundPrompt". The same 
settings are used for Raman and IR. Set the strings to the empty string to revert to the default 
prompts. 
 
History:  This is an enhancement for 7.1.   

 
Interferogram peak level readable from Nicolet Series instruments. 

Description: The new DDE parameter “BenchStatus InterferogramLevel” can be used to read 
the current interferogram level of a Nicolet Series instrument. This is available when data 
collect is active or inactive. The data is returned in the format 
<IfgMaxVal>,<IfgMinVal>,<IfgMaxPosition>,<IfgMinPosition>. For example, the string “5.3, 
-2.4, 8231, 8256” indicates the maximum is 5.3, the minimum is –2.4, the max occurs at data 
point 8231 and the min occurs at data point 8256.  
 
History:  This is an enhancement for 7.1.   

 
Environment variables supported in run commands 

Description: The DDE commands Run, RunMacro, and RunMacroAndWait now allow 
Environment variables to be used to specify the location of the target. For example, the 
command [RunMacro “%OMNICDATA%\macro\SimpleTrans.mac”] will launch the 
SimpleTrans.mac macro from the macro subdirectory of the location set in the OMNICDATA 
environment variable. Note that OMNICDATA is set by the OMNIC installer and is normally set 
to C:\My Documents\OMNIC unless the user chooses to install to a different location. Other 
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environment variables can be used as well as long as they have been initialized prior to the 
DDE command. 
 
History:  This is an enhancement for 7.1.   

 
OMNIC DS 
 
Administrator program requires username and password at startup. 

Description: The Thermo Administration program now requires user authentication when the 
program starts to verify the user identity matches the user that is logged on to Windows. 
 
History:  This is an enhancement for 7.1.   

 
Administrator program handles large networks better. 

Description: The Thermo Administration program will switch to initiating the accounts on the 
local PC, rather than the accounts on the login domain if the enumeration takes a long time. An 
edit control has been added that allows user names to be entered manually so enumeration 
can be avoided. Accounts are not re-enumerated when switching from the access control 
portion of the tree to the policy portion. 
 
History:  This is an enhancement for 7.1.   

 
Administrator program more easily adds or removes access control entries for all access 
control functions. 

Description: The Thermo Administration program has two new menu items. The “Add to All 
Access Control Items…” will add an Allow or Deny entry for the specified user to every function 
in the Access Control section of the application. The “Add to All Access Control Items…” will 
add an Allow or Deny entry for the specified user to every function in the Access Control section 
of the current application. The “Remove From All Access Control Items…” will remove the entry 
for a specified user or group from all functions in the Access Control section of the current 
application.  
 
History:  This is an enhancement for 7.1.   

 
Support for signing Libraries. 

Description: Spectral libraries can now be signed using the new Sign button in Library 
Manager. The signature status of the selected library is shown at the bottom of the Library 
Manager Window.  
 
History:  This is an enhancement for 7.1.   

 
Support for signing spectral group files (.spg). 

Description: Spectral group files can now be signed and verified using the Sign File and Verify 
File items in the File menu.  
 
History:  This is an enhancement for 7.1.   

 
Sign multiple files with a single authentication prompt 

Description: The Sign File item in the File menu now allows multiple files to be selected for 
signing. The authentication prompt used to enter the password and signature reason is only 
displayed once and the same reason for signing is applied to all files.  
 
History:  This is an enhancement for 7.1.   
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Sign the selected spectra without using a file navigation dialog. 

Description: A new item in the File menu called Sign Spectra will sign the selected spectra. If 
the spectra already have a filename associated with them, the file navigation dialog does not 
need to be displayed.  
 
History:  This is an enhancement for 7.1.   

 
Atlµs v7.1 
 
The Atlµs™ product has been completely revised. See the product documentation for 
information on changes to Atlµs. 
 
Support for Nicolet Series Bench 

Description: The Nicolet Series Bench drivers now support the Continuµm™ XL. 
 

History:  This is an enhancement for 7.1. 
 
 
Resolved Issues 
 
OMNIC 
 
Company Name change 

Description:  The company name has been changed from “Thermo Nicolet” to “Thermo 
Electron” in many places, such as copyright notices of help files and readme files. 

History:  This issue occurred in OMNIC 7.0.  
 
Current Tool changed after running a Macros Basic macro 

Description:  The selected tool may be changed incorrectly after running a Macros Basic 
macro. 

History:  This issue occurred in OMNIC 7.0.  
 
Spectrum title corrupted by Automatic Baseline Correct. 

Description:  A bug that caused the spectrum title to be corrupted when Automatic Baseline 
Correct was done has been fixed. This only happened if the title was at maximum length when 
the function was applied. 

History:  Problem introduced in 7.0. 
 
Asterisk appended to spectrum filename  

Description:  When spectra were saved using the Save As dialog and the “Save as type” was 
set to show all files, an asterisk would be appended to the filename entered by the user. This 
has been fixed so nothing is appended to the filename. 

History:  Problem introduced in 7.0. 
 

X Axis not drawn at start of data collect  
Description:  At the start of Collect Sample or Collect Raman, the X Axis would sometimes be 
left blank until a spectrum was added to the window. This drawing problem has been fixed. 

History:  Problem introduced in 6.0. 
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X Axis always in decreasing order in Collect Window  

Description:  The X Axis in the Collect Window was always displayed in decreasing order. 
This has been changed to display the axis in the same order that the default limits are specified 
in the Window tab of the Options dialog. 

History:  Problem introduced in 6.0. 
 
X Axis limits changed at end of Raman collect  

Description:  When a Raman collect completed and the collected spectrum was added to a 
window, the X Axis of the window was reset to the zoomed out limits of the collected spectrum 
(always in decreasing order) and the default X Axis limits for new windows in the options were 
changed to these same values. All of this behavior has been removed so that adding spectra to 
a window at the end of a Raman collect behaves the same as all other methods of adding a 
spectrum to a window.  

History:  Problem occurred at least as far back as OMNIC 4. 
 
Multiple copies of Spectral Group files sent with Mail Spectra  

Description:  If more than one spectrum from the same .spg file were sent in the same email 
suing the Mail Spectra menu item, multiple copies of the .spg file were included in the email. 
This has been fixed so that only a single copy of the group file is attached.  

History:  Problem introduced in 7.0. 
 
Collection and Processing Window garbled after closing spectral window  

Description:  If a Collection and Processing Information (CPI) window was left open after the 
spectral window it originated from was closed, some of the fields of the CPI window would 
become garbled. This has been fixed.  

History:  Problem in all previous versions of OMNIC. 
 
Interferogram peak not in display window of Experiment Setup  

Description:  In the bench tab of Experiment setup, if the save range was changed such that 
sample spacing had to change, the limits of the interferogram window were not adjusted 
correctly so the new peak position was within the displayed window. This has been fixed.  

History:  Problem introduced in 7.0. 
 
Overlay feature of Search results does not work when decimal point is a comma  

Description:  When Windows is set to use a comma as the decimal point, which is the default 
for some locales such as German, the overlay feature in the search results window did not 
work. This has been fixed, as well as problems with changing the number of search results 
using the Modify Display button.  

History:  Problem introduced in 7.0. 
 
Use Fixed Scale during data collect not applied to interferogram collects  

Description:  The “Use fix Y-Axis limits in collect window” feature did not work when the final 
format of the collect was set to interferogram. This has been fixed, but the feature still does not 
apply to singlebeam collects so that background collects are not displayed using the limits 
intended for samples. Also, an error message is now displayed if the upper and lower values 
are set to the same value. 

History:  Problem introduced in 7.0. 
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Buttons at bottom of Experiment Setup and Options cutoff when large fonts are used  

Description:  The buttons at the bottom of the Experiment Setup and Options dialog were 
cutoff when large fonts were used for the dialog caption. Selecting one of the Appearance 
Schemes from the Windows Display Properties dialog can set this large font. This has been 
fixed.  

History:  Problem introduced in 7.0. 
 
Dialog font intermittently incorrect  

Description:  When the OMNIC dialog font was changed using the Options dialog, some 
dialogs would intermittently use the system font instead. This has been fixed. 

History:  Problem introduced in 6.0. 
 
Extended Search text fields too short  

Description:  The text fields on the Extended Search tab of Library Setup were incorrectly 
limited to around twelve characters (depending on font size). The dialog now allows scrolling 
and uses the first 60 characters entered into these fields. 

History:  Problem occurred at least as far back as 5.2. 
 
Green check appears before bench communications established  

Description:  With Nexus and Magna instruments, the green check indicating good bench 
status may appear before bench communications had been established. In this case, the green 
check appears, but the items in the collect menu remain disabled. This has been fixed. 

History:  Problem introduced in 6.2. 
 
Loading an old (pre 7.0) experiment file does not reset new fields  

Description:  If an experiment file created with a version of OMNIC prior to 7.0 is loaded, the 
new fields added in 7.0 are not reset to their default values. These fields include the auto-blank 
regions, the separate number of background scans and the Y-axis limits used during data 
collect. This has been changed so the fields added for 7.0 are reset to their default values so 
the older experiment files give the same behavior they did when they were created. 

History:  Problem introduced in 7.0. 
 
Problems with beamsplitter recognition on Nicolet Series instruments  

Description:  Problems on Nicolet Series instruments with the wrong beamsplitter being 
recognized as installed after an experiment file has been loaded have been fixed. 

History:  Problem introduced in 7.0. 
 
OMNIC DS 
 
Editing annotation in the Annotation Information dialog corrupts signature status display. 

Description: When annotation from a signed spectrum is editing using the Annotation 
Information dialog (available from the Collection and Processing Information window), the 
displayed signature status of the spectrum with change to the string “Text”. This has been fixed. 
 
History:  Problem introduced in 7.0. 

 
Known Issues 
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Tabbing in Options and Experiment Setup does not move between controls. 
Description:  Pressing the tab key does not move the keyboard focus from one control to the 
next in the Options and Experiment Setup dialogs. 

Recommendation:  Use the mouse to move keyboard focus to a control. 

History:  Problem occurred in all previous versions. 
 
Inserting a smart accessory during a data collect. 

Description:  On a Nicolet series instrument, if a smart accessory is installed while a data 
collect is active, the experiment file will be changed in the middle of the collect, possibly 
resulting in bad scans. Other instrument types suppress the change if a data collect is active. 
However, if an accessory is inserted while the collect is active, the IR beam will almost certainly 
be disrupted resulting in bad scans anyway.  

Recommendation:  Accessories should not be changed during data collect. 

History:  Problem introduced in 7.0. 
 
OMNIC v7.0 
 
New Features 
 
OMNIC 
 
Anti-collision for annotations in Find Peaks. 

Description:  The Find Peaks operation in OMNIC now adjusts the location of peak labels to 
avoid overlapping labels as much as possible. 

 
History:  This is an enhancement for 7.0   

 
Support for Nicolet Series instruments. 

Description:  Support for the Nicolet Series line of instruments is now included. This includes 
providing control for filter wheels, screen wheel, polarizer, turbo source, and function buttons 
on the front of the instrument. 

 
History:  This is an enhancement for 7.0   

 
Grid of controls used on Bench tab of Experiment Setup. 

Description:  The controls on the bench tab of the Experiment Setup dialog have been 
consolidated into a grid to reduce clutter, make better use of space and handle dynamic bench 
configurations better. This required a few other small changes to the layout of the Bench tab. 

 
History:  This is an enhancement for 7.0   
 

Freeze button on Bench and Diagnostic tabs of Experiment Setup. 
Description:  A “Freeze” button has been added to the bench and diagnostic tabs of 
Experiment setup that will snapshot the currently displayed interferogram or singlebeam and 
leave is displayed in the window so it can be compared to subsequent scans. 

 
History:  This is an enhancement for 7.0   

 
New Configure tab of Experiment Setup. 

Description: A Configure tab has been added to the Experiment Setup dialog. This tab has the 
“Configure Bench” button that was on the Diagnostics tab, along with controls for providing 
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names for the positions of the filter wheels and screen wheels (if they are present) and setting 
up the IR Source rest mode for instruments that support this feature. Items set up this tab are 
not saved in experiment files. 

 
History:  This is an enhancement for 7.0   

 
X Limits of live display persist in Experiment Setup. 

Description: The X limits of the live display are not saved when the dialog is closed and reused 
when you redisplay the dialog. The limits are also saved when you switch to between the 
Bench and Diagnostics tabs. The are not saved when you exit OMNIC. 

 
History:  This is an enhancement for 7.0   

 
Background scans optionally set separate from Sample scans. 

Description:  The Collect tab of experiment setup now provides an option to specify a different 
number of scans for the background than the sample. 

 
History:  This is an enhancement for 7.0   

 
Option to set Y-Limits for use during collect. 

Description:  The Collect tab of Experiment Setup now provides an option to specify a Y limits 
to be used in the collect window during the collect operation. This can be used to avoid 
autoscaling on large peaks that are not of interest. 

 
History:  This is an enhancement for 7.0   

 
Auto-blank regions during data collect. 

Description:  The Advanced tab of Experiment Setup now provides a grid for entering up to 
four spectral regions that are to be blanked during data collection. The regions can be turned 
on and off individually. This new auto-blanking feature can be used when collecting with 
accessories that have totally absorbing regions to prevent auto-scaling to these large peaks. 

 
History:  This is an enhancement for 7.0   
 

Marco assigned to front panel button on instrument. 
Description:  The Advanced tab of Experiment Setup now provides a place to identify a macro 
that will be executed when the “Macro” button on the front panel of the Nicolet Series 
instrument is pressed. 

 
History:  This is an enhancement for 7.0   
 

Improved peak annotations. 
Description:  The annotations created with the peak height and area tools now use lines or 
shading to highlight the measured peak. 

 
History:  This is an enhancement for 7.0   

 
Annotations viewable as a table. 

Description:  The annotations associated with a spectrum can now be viewed as a table by 
clicking the new “Annotations” button in the Collection and Processing Information window. The 
text portion of the annotation can be editing in this window, but the location and baseline 
information cannot. The table can be copied to the clipboard. 

 
History:  This is an enhancement for 7.0   
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Mail Spectra. 

Description:  A new Mail Spectra item in the File menu provides support for sending the 
currently selected spectra as attachments to an email message. The email is sent using the 
default account for the logged on user. 

 
History:  This is an enhancement for 7.0   

 
Additional Y Scaling buttons. 

Description:  Two additional buttons are now provided in the View Finder control to improve 
scaling in the Y dimension. 

 
History:  This is an enhancement for 7.0   

 
List of spectral titles auto-sizes. 

Description:  The drop down list of spectra at the top of the main spectral window is now sized 
so that empty rows are eliminated and do not obscure the spectra display. 

 
History:  This is an enhancement for 7.0   

 
Additional techniques supported for Derivative. 

Description:  The Derivative operation on the process menu has been enhanced to three 
choices of techniques: 1) First different (the only technique supported in previous versions), 2) 
Savitzky-Golay and 3) Norris. 

 
History:  This is an enhancement for 7.0   

 
Overlay spectra in Search Results window. 

Description:  The spectral display in the Search results window now can be switched between 
stack and overlay mode. This allows the unknown to be overlaid with one or more of the search 
hits. 

 
History:  This is an enhancement for 7.0   

 
Multifile .SPC file read. 

Description:  OMNIC now read all of the spectra in GRAMS .SPC files that contain more than 
one spectrum. 

 
History:  This is an enhancement for 7.0   

 
New look for tabbed dialogs. 

Description:  Some cosmetic changes were made to the look of the tabbed containers used for 
the Options dialog and Experiment Setup dialog. 

 
History:  This is an enhancement for 7.0   

 
Saving spectra from Spectral Group files now defaults to saving as individual files. 

Description:  In earlier versions of OMNIC, when you read in spectra from a spectral group file 
(.spg) and then did a save with one of the spectra from the .spg file selected, the group file 
would be overwritten with a new group of just that one selected spectra. To avoid that problem, 
save operations on spectra that were loaded from .spg files default to saving as individual 
spectra in .spa files. 

 
History:  This is an enhancement for 7.0    
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Floating-point exceptions now handled more gracefully.  

Description:  Floating point exceptions that occur in OMNIC are now caught and 
acknowledged so that the application does not exit. For example, in earlier versions of OMNIC, 
you could enter very large numbers in the Spectral Math window and generate a floating-point 
exception that would cause OMNIC to exit. This error is now caught and handled properly. 

History:  This issue occurred in OMNIC DS version 6.2.  
 
OMNIC DS 
 
Administrator program translated. 

Description: The Thermo Administration program is now translated into several languages. 
 
History:  This is an enhancement for 7.0.    

 
Warning at OMNIC start for invalid directory policies. 

Description: OMNIC now gives a warning at startup if any of the initial directory policies set in 
the Thermo Administration program are not valid. This is done at OMNIC startup rather than in 
the Thermo Administration program to handle cases where directories are deleted after the 
policies are set. 
 
History:  This is an enhancement for 7.0.    

 
SST and TRS 
 
Synch Hold Addition to SST 

Description: A new option has been added to AM, PM, and TRSS step-scan collects. This is 
the ability to specify that the stepping be triggered externally rather than occurring 
automatically after the data collection. This external trigger should be connected to the bench 
via the SYNCH BNC. If this feature is enabled, and the logic level on this input is high after the 
data collection, the stepping to the next mirror position will be delayed until the level goes low. 
This option is available only if the firmware is version 7.16 or later 
 

History:  This is an enhancement for 7.0. 
 
Resolved Issues 
 
OMNIC 
 
Collect time-out when set to ssp1 @ .125 cm-1 resolution with PCI card 

Description:  When data is collected about 7879 cm-1 at .125 resolution, data collect timeouts 
could occur. Only occurred on Magna or Nexus instruments that used a PCI interface card. 
This has been fixed. 

History:  This issue occurred in OMNIC version 6.1 and 6.1a.  
 

Problems showing data in increasing X order fixed.  
Description:  If the X-Limits were set so the left limit was less than the right limit (increasing 
order), a bug caused OMNIC to switch the order back to decreasing when the View Finder 
control was touched. This appeared in the Bench tab of Experiment setup and could also occur 
in the main spectral window if the limits were manually set. 

History:  This issue occurred in OMNIC version 6.2 and earlier. 
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File types recorded separately for Open and Delete file dialogs.  
Description:  The Open and Delete file dialogs use to share a setting to record the last file type 
the user selected so that type could be selected again the next time the dialog was shown. This 
gave unexpected results because the list of file types in the two dialogs is not the same. There 
are now two separate settings to record the last file type so the open and delete dialogs each 
remember the last selection correctly. 

History:  This issue occurred in OMNIC version 6.2 and earlier. 
 
Filename now shows when bitmap pasted into external program.  

Description:  If the filename field of Sampling information is turned on when a copy is done of 
the spectral window and pasted into an external program such as Microsoft Word, the filename 
was not shown in the pasted image. This has been fixed. 

History:  This issue occurred in OMNIC version 6.2 and earlier. 
 
Mpanel32.exe no longer installed.  

Description:  The Mpanel32.exe program provided a way to launch Macros Basic macros in 
the original versions of OMNIC that did not have a toolbar (versions 1 and 2). Since macros can 
now be assigned to the toolbar, this program is no longer needed so it has been removed from 
the install. 

History:  This issue occurred in OMNIC version 6.2 and earlier. 
 
Collection and Bench parameters saved in new user libraries for each spectrum.  

Description: A limitation of user libraries has been eliminated for new libraries created with 
OMNIC 7. When a spectrum is extracted from a user library, the true collection and bench 
parameters of that were used to collect the spectrum are now retrieved from the library rather 
than the ones from the first spectrum in the library. If the spectrum was deresolved or 
hyper-resolved as it was added to the library, looking at the sample spacing vs. the resolution 
can identify it. A warning will be displayed if a spectrum needs to be hyper-resolved when 
added to a library. 

History:  This issue occurred in OMNIC version 6.2 and earlier. 
 
Spectrum filename can be displayed in Search window.  

Description: The filename of the unknown spectrum now displays properly in the Search 
window when the display setup has this feature turned on.  

History:  This issue occurred in OMNIC version 6.2 and earlier. 
 
Improved parsing of OMNIC command line.  

Description:  Improvements were made to the parsing of the OMNIC command line so that 
double clicking on files in Explorer with filenames that included dashes is now handled 
correctly. 

History:  This issue occurred in OMNIC DS version 6.2.  
 
Changes made to spectra extracted from report do not affect report display.  

Description:  A bug that caused the display of reports to be modified when changes were 
made to spectra extracted from the report has been fixed. The changes shown on the report 
display were never written to the report, but the display was mistakenly being modified. 

History:  This issue occurred in OMNIC DS version 6.2.  
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OMNIC DS 
 
Saving data to protected directories works as installed.  

Description:  The feature of DS that allows users to save data into directories they would 
normally not have write permission on no longer requires administrators to manually change 
the permissions on each users temp directory. This bug has been fixed so that the feature 
works with the permissions set at install. 

History:  This issue occurred in OMNIC DS version 6.2.  
 
Problems signing files after password change on Windows XP fixed.  

Description:  A security feature of Windows XP invalidates the default PKI keys under some 
circumstances when a password change occurs. When XP service pack 1 is installed, this only 
occurs if the administrator forces a password change. Without service pack 1 installed, this can 
occur even when the user changes the password. After the default keys are invalidated, 
OMNIC will no longer be able to sign or verify files for that account. A change has been made in 
7.0 so that OMNIC does not use the default keys and is therefore not affected by password 
changes. 

History:  This issue occurred in OMNIC DS version 6.2.  
 
Print feature of Search window now uses printing policy correctly.  

Description:  The print feature of the Search results window is now disabled if the unknown 
spectrum has not been saved and the security policy is set to prevent printing of unsaved data. 

History:  This issue occurred in OMNIC DS version 6.2.  
 
Spectra extracted from library can now be printed regardless of printing policy.  

Description:  The policy that controls printing of unsaved data was preventing spectra 
extracted from a user library from being printed. These spectra are now correctly marked as 
saved so they can be printed regardless of the policy setting. 

History:  This issue occurred in OMNIC DS version 6.2.  
 
Windows key no long gives access to explorer features in open/save dialogs.  

Description:  The policy that prevents users from having access to the Explorer features such 
as delete and rename could be defeated in 6.2 by pressing the Windows key. This has been 
fixed so user cannot access Explorer functions. 

History:  This issue occurred in OMNIC DS version 6.2.  
 
Event log entries now made for file deletions for GAML files.  

Description:  File delete entries were not being made when GAML files were deleted. These 
entries are now made, but the filename recorded for all delete operations is the 8.3 version, so 
they show up as deletions of .GAM files. 

History:  This issue occurred in OMNIC DS version 6.2.  
 

 
OMNIC v6.2 
 
New Features 
 
OMNIC 
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Read/Write GAML files. 
Description: Added ability to read and write spectra in GAML format. 
 
History:  This is an enhancement for 6.2.    

 
New Advanced ATR correction. 

Description: Added New Advanced ATR correction. 
 
History:  This is an enhancement for 6.2.    

 
Insertion and deletion date now available for library spectra. 

Description:  With libraries created in OMNIC 6.2, the insertion and deletion dates of each 
spectrum is tracked. The dates are visible in the Library Spectra tab of library manager. This 
information is not available for libraries created prior to 6.2, even when new spectra are added 
to these libraries. 
 
History:  This is an enhancement for 6.2.    

 
Spectra deleted from user libraries remain visible until the library is compressed. 

Description:  A new column has been added to the Library names tab of Library Manager with 
the heading “Del”. A red X in this column indicates that the spectrum has been deleted from the 
library. Compressing a library permanently removes the deleted spectrum from the library. 
After compression no red X's are displayed in the “Del” column. 
 
History:  This is an enhancement for 6.2.    

 
Display help files in three-pane mode. 

Description:  Additional files are being installed so that help files will be displayed in the more 
modern three-pane mode. 
 
History:  This is an enhancement for 6.2.    

 
Resizing Open/Save dialogs. 

Description:  Several open/save dialogs where changed so they can be sized by the user. 
Also, small improvements were made in the spacing/alignment of controls on open/save 
dialogs. 
 
History:  This is an enhancement for 6.2.    
  

Remember size of Spectrum information window 
Description:  If the Spectrum information window is enlarged beyond it’s default size, the new 
size is saved and used as the initial size for the window the next time it is opened.  
 
History:  This is an enhancement for 6.2.    
  

Record old data spacing for Change Data Spacing 
Description:  The history entry made in the spectrum header when a Change Data Spacing 
operation is performed now includes the old data spacing as well as the new data spacing.  
 
History:  This is an enhancement for 6.2.    
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Raman operations generate history records. 

Description:  The Raman operations Shift, Un-shift and Instrument correct now generate 
records in the spectrum history. 

 
History:  This is an enhancement for 6.2.    

 
Change Data Spacing history now includes old data spacing. 

Description:  The history record generated when a change data spacing operation is done 
now includes both the old and the new data spacing. Previous versions only record the new 
data spacing. 

 
History:  This is an enhancement for 6.2.    

 
OMNIC DS 
 
Admin program for configuring user authorization. 

Description:  Authorization to use any OMNIC function now controlled by separate 
Administration program. 
 
History:  This is an enhancement for 6.2.    

 
Reasons for Digital Signatures controlled by Admin program. 

Description:  Access to reasons for signatures now controlled in the Admin app. 
 
History:  This is an enhancement for 6.2.    

 
Event Log for significant events. 

Description:  Significant events such as saving data and signing files are recorded in an 
isolated section of the NT Event log. Modifications, deletions and renaming of important file 
types generate log events, even when they are made outside of OMNIC.  
 
History:  This is an enhancement for 6.2.    

 
Saving data to directories with restricted access. 

Description:  Added ability to save files to directory that has very restricted access so lab 
manager be assured files will not be renamed or deleted. Even with this restricted access, 
OMNIC is able to apply digital signatures to the files. 
 
History:  This is an enhancement for 6.2.    

 
Sign file gives three chances to enter correct password. 

Description:  The sign file dialog now gives the user three chances to enter the correct 
password. 
 
History:  This is an enhancement for 6.2.    

 
SST and TRS 
 
New Sample Spacing choices 

Description:  Increased range of allowed sample spacings for step scan experiments from 8 to 
>100. (Requires bench firmware v. 7.14) 
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History:  This is an enhancement for 6.2.    
 
Improved multiple-trigger mode 

Description:  Improved multiple-trigger mode operation in TRSS collects by allowing shorter 
trigger intervals. (Requires Gage driver v. 3.60 or later) 
 
History:  This is an enhancement for 6.2.    

 
Resolution selection for step-scan time-resolve 

Description:  Made resolution selection more flexible for step-scan time-resolved collects. 
 
History:  This is an enhancement for 6.2.    

 
Y-axis added to TRSS real-time display 

Description:  Y-axis added to TRSS real-time display. 
 
History:  This is an enhancement for 6.2.    

 
Step-Scan Settling time now set with edit control 

Description:  The Settling time control in the Step-Scan Time-Resolved setup dialog has been 
changed from a list box to an edit control to allow more flexible setting of this parameter. The 
minimum value is 1 msec or larger if more time is required for data transfer during 
multiple-trigger collection. 
 
History:  This is an enhancement for 6.2.    

 
Resolved Issues 
 
OMNIC 
 
Change the default setting for the Bench and Collect checkboxes to off in the Quant Setup 
dialog.  

Description:  Change in default behavior.  

History:  This issue occurred in OMNIC version 6.1a and earlier.  
 

Change how the spectral limits in a new Raman library will be created. 
Description:  Correct a problem with frequency normalization whit Raman shifted data. This is 
now the correct behavior, but there will be a difference between old Raman libraries and new 
Raman libraries with respect to how the spectral limits are normalized. 
 

History:  This issue occurred in OMNIC version 6.1a and earlier.    
 
Change to not display an error when a user chooses not to overwrite a signed file. 

Description:  Eliminate an erroneous error message that was displayed when the used 
chooses not to overwrite a signed file. 
 

History:  This issue occurred in OMNIC version 6.1a and earlier.    
 
Fixed a bug that occurred when OMNIC was installed in a path that used multi-byte 
Japanese characters. 

Description:  Fixed a bug that occurred when OMNIC was installed in a path that used 
multi-byte Japanese characters. 



Thermo Scientific  OMNIC Release Notes 
  OMNIC 8.3     

Thermo Scientific 
Page 64 of 85 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    

 
On a clean install, the default for peak picks will be sorted on Position, not intensity. 

Description:  On a clean install, the default for peak picks will be sorted on Position not 
intensity. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    

 
Setting access rights to temporary directory. 

Description:  A change was made to set the users temporary directory to have wide-open 
access each time OMNIC starts. This allows ancillary OMNIC tools to write to this directory. 

 
History:  This issue was not a problem in earlier versions of OMNIC.    

 
Turn off display of signature information in reports. 

Description:  Changed the report printing to turn off display of signature information for spectra 
because spectra in reports are never signed. Only the notebook can be signed. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    

 
Spectra from signed .spa files appear modified when loaded. 

Description:  Fixed a bug where spectra loaded from signed .spa files were considered 
modified as soon as they were read. This bug caused a prompt to resave the spectra when the 
window was closed, even though the spectra had not actually been modified. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    

 
Change to allow up to 10000 series files in sequence rather then 100. 

Description:  The automatically generated filenames for series files now have enough digits to 
allow 10000 files in the same directory rather than 100. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    

 
Cleanup drawing flaws in skinned dialogs. 

Description:  Some small improvements to the skinned drawing of dialogs were made, such as 
providing a background color to list boxes and using a solid brush color if pattern bitmaps are 
not available. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    

 
Fixed a bug that would disable the spectrometer tour by mistake in some cases. 

Description:  Fixed a bug that would disable the spectrometer tour by mistake in some cases. 
 

History:  This issue occurred in OMNIC version 6.1a and earlier.    
 
MRU list saved on a per-user basis. 

Description:  The MRU list of spectra at the end of the File menu is now stored in the registry 
on a per-user basis rather than in Omnic32.ini. The main reason for this change is that some 
user sites prefer to set all files in the Windows directory (including Omnic32.ini) as read-only for 
standard users. When this is done, OMNIC’s MRU list would not work. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    
 



Thermo Scientific  OMNIC Release Notes 
  OMNIC 8.3     

Thermo Scientific 
Page 65 of 85 

OMNIC sub-installers have been changed to use Microsoft Installer. 
Description:  Many of the OMNIC sub-installers have been changed to use the new Microsoft 
Installer technology. This was done for improved maintainability since the old InstallShield 
installer is no longer supported. 

 
History:  This change was made to avoid future problems.    

 
Spikes in files converted from Perkin Elmer format fixed. 

Description:  Fixed the Perkin Elmer spectral conversion code so that it does not produce 
spikes when data values are near zero. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    

 
Undo Scale must be done twice. 

Description:  A bug that required Undo Scale Change to be done twice to undo changes made 
with the zoom buttons of the view finder was fixed. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    
 

Raman Instrument correct works with a reference file. 
Description:  A bug that prevented using a reference file for Raman Instrument Correct was 
fixed. 

 
History:  This issue occurred in OMNIC version 6.0, 6.1 and 6.1a.    
 

Options changes recognized in Find Peaks window. 
Description: Find Peaks windows now recognize changes to options such as annotation 
orientation and number of digits. Earlier versions required the Find Peaks window to be closed 
and reopened for the change to take effect. 

 
History:  This issue occurred in OMNIC version 6.1a and earlier.    

 
Drawing shaded regions on 32 bit depth ATI cards changed. 

Description: A different technique is now used to draw shaded regions. The old technique did 
not work on some ATI cards when the bit depth was set to 32 bits. 

 
History: This issue occurred in OMNIC version 6.1a and earlier.   

 
Additional message generated if file signing canceled. 

Description:  If a user is required to sign a file as part of the save operation, but cancels the 
signature dialog or enters an invalid password 3 times, an error message is now displayed 
indicating the file has been saved, but not signed. 

 
History:  This issue occurred in OMNIC version 6.0, 6.1, and 6.1a.    
 

References to Thermo web site changed. 
Description:  The references to the Thermo Electron web site have been changed to 
www.thermo.com/Spectroscopy. 

 
History:  This issue occurred in OMNIC version 6.0, 6.1, and 6.1a.   
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Crash when invalid gain read from a file. 
Description:  A bug that caused a crash when an invalid gain was read from a spectrum file 
was fixed. 

 
History:  This issue occurred in OMNIC versions 6.1, and 6.1a. 
 

More scans button on collect window disabled for Mattson. 
Description:  A problem adding additional scans after a data collect was initiated on Mattson 
benches was fixed by disabling the feature when OMNIC is running with one of these benches. 

 
History:  This issue occurred in OMNIC versions 6.1, and 6.1a. 

 
Failure to overwrite read-only configuration files now reported. 

Description:  Attempting to save over the top of a read-only configuration file now generates 
an error message indicating the save failed. In prior versions, the save failed with no indication. 

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.    

 
Failure of Change data spacing now reported. 

Description:  When the Change data spacing command fails, an error message is displayed. 
Attempting to change the data spacing of an interferogram is an example of how the command 
can fail. 

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.    

 
Hourglass cursor now shown during Other Conversions. 

Description:  The hour glass cursor is now displayed during the other conversions command 
since some of these conversions can be time consuming. 

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.    

 
Digital Signature status not shown properly for Almega spectra 

Description: A bug that prevented the digital signature status from being displayed for Almega 
spectra was fixed. 

 
History:  This issue occurred in OMNIC versions 6.0, 6.1, and 6.1a.   

 
Text drawing bug in collect status window fixed 

Description:  A bug that caused several text strings to be drawn on top of one another in the 
collect status window was fixed. This occurred if the experiment description and title were 
blank. 

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.   

 
Spectra filename lost after an undo operation fixed 

Description:  If an operation is performed on a spectrum that had been saved to a file and then 
the operation undone, the spectrum would appear as if it had never been saved to a file and the 
user would have to re-assign a filename. This is now fixed.  

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.   

 
Crash when adding very long annotation fixed 

Description:  If a piece of annotation was added with a very long text string (2000 characters), 
a crash could occur. This has been fixed by checking for a maximum buffer size.  



Thermo Scientific  OMNIC Release Notes 
  OMNIC 8.3     

Thermo Scientific 
Page 67 of 85 

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.   

 
Remove DC offset from interferograms read from Mattson files. 

Description:  A correction is now done to remove the DC offset from interferograms read from 
Mattson files before the data is displayed or processed. 

 
History:  This issue occurred in OMNIC versions 6.0, 6.1, and 6.1a.   

 
Normalize Scale command failed when performed twice. 

Description: A problem was fixed with the Normalize Scale command. If the command was 
performed twice on the same spectrum the results were invalid. On some PC’s a floating-point 
exception was generated and OMNIC would exit. 

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.  

 
Change to the default value in Quant setup. 

Description: In the Quant Setup dialog, the default setting for the Bench and Collect check 
boxes was changed from on to off. 

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.  

 
Raman data added to library had poorly registered X-axis values. 

Description: When a Raman spectrum was added to a library the x-axis values were not 
properly registered to the laser frequency. This problem is now corrected. 

 
History:  This issue occurred in OMNIC versions 6.1a and earlier.  

 
Initial directory for Configuration files is now the same as parameter files 

Description: The initial directory for configuration files was changed to be the same as the 
initial directory for parameter files instead of options. 
 
History: This issue occurred in OMNIC version 6.1a and earlier.    

 
GC-FTIR External trigger feature fixed 

Description: A problem where a Series GC collect waiting for an external trigger from the GC 
device would start before the trigger signal was issued was fixed. 
 
History: This issue occurred in OMNIC version 6.1a and earlier.    

 
SST and TRS 
 
Display of Channel B/A ratio in PEM setup dialog 

Description: Fixed bug in display of Channel B/A ratio in PEM setup dialog. 
 
History: This issue occurred in OMNIC version 6.1a and earlier.    

 
Collect time-out problem in step-scan dialogs. 

Description: Fixed collect time-out problem in step-scan setup dialogs when averaging time is 
large (> 3 sec). 
 
History: This issue occurred in OMNIC version 6.1a and earlier.    
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Phase Analysis dialog. 
Description: Modified Phase Analysis dialog so that IP spectrum must be in upper window. 
 
History: This issue occurred in OMNIC version 6.1a and earlier.    

 
SST menu item names. 

Description: Changed SST menu item names and labels for several controls in setup dialogs. 
 
History: This issue occurred in OMNIC version 6.1a and earlier.    

 
OMNIC v6.1a 

 
Resolved Issues 
 
OMNIC  
 
The new GMT time zone information in the Data Display Information section of the Spectral 
History is displayed improperly when on the positive side of the grand meridian. 

Description:  The title contains the correct time stamp (Mon Jul 29 14:39:05 2002 
(GMT+02:00)), but DS date and time in the spectral header says " 29-07-2002 15:40:36 
(GMT-11330037:44)".  

History:  This issue occurred in OMNIC version 6.1. Tracking number: V&V3677. 
 

Changed the Spectrometer Tour routine to not check the CDROM drive for the tour.   
Description:  This fixes a message (abort, ignore, retry) that pops up on some computers and 
OS combinations when a CDROM is not in the drive. 

History:  This issue occurred in OMNIC version 6.1.   
 

Rapid scan collects stalled on Windows NT 4.0 systems. 
Description:  Rapid scan was not functioning properly on Windows NT® 4.0 systems. 

History:  This issue occurred in OMNIC version 6.1 driver. Tracking number: V&V3693. 
 

Intermittent driver problem could result in a system lockup during data collect. 
Description:  This issue was discovered during internal testing. Rapid scan was not 
functioning properly on Windows NT 4.0 systems. 

History:  This issue occurred in OMNIC version 6.1 driver.   
 
 

InterpretIR+ 
 
InterpretIR+ did not install from the Update CD. 

Description:  InterpretIR+TM did not update the previous version since the name of the 
executable had changed. This has been corrected.  

History:  This issue occurred in OMNIC version 6.1 Update CD. 
 

Val-Q 
 
Some Autotest results report failures when run under some foreign languages. 

Description:  The references used in the comparison were created on a system where 
decimals are used as the numerical separator. Changed software testing module in Val-Q to 
recognize commas in place of decimals as valid separators. 



Thermo Scientific  OMNIC Release Notes 
  OMNIC 8.3     

Thermo Scientific 
Page 69 of 85 

History:  This issue occurred in OMNIC version 6.0a.   
 

Autotest report four failures when run on a system that does not have the DS option 
installed.   

Description:  Autotest was reporting failures because it cannot read the digital signature 
portion of a data file without having the DS option installed. Autotest changed to perform the 
correct comparison with and without the DS option. 

History:  This issue occurred in OMNIC version 6.1 driver.   
 

View Stage 
 
Cannot view data during data collection. 

Description: Changed FT Raman software to not turn off the Raman View Stage lamp when 
collecting data since the lamp LED does not affect Raman data. This allows you to view data 
while collecting. 

History:  This issue occurred in OMNIC version 6.1. 
 

Almega 
 
Photobleaching not operating properly. 

Description:  Correction to PolySNR test which caused photobleaching to be done twice. 

History:  This issue occurred in OMNIC for Almega version 6.1. 
 

Slit selection changing when switching tabs. 
Description:  The 10 um slit option did not remain selected when changing tabs. 

History:  This issue occurred in OMNIC for Almega version 6.1. Tracking number: V&V3634.  
 

Display limits when viewing data in nanometers.. 
Description: Display limits for preview data collect were incorrect when final format is in 
nanometers. 

History:  This issue occurred in OMNIC for Almega version 6.1. Tracking number: V&V3635. 
 

Updating previous Almega installations with the Update CD. 
Description:  The Almega driver did not update when installed from the Update CD. This has 
been corrected. Does not affect new installations. 

History:  This issue occurred in OMNIC for Almega version 6.1.  
 
SST and TRS 
 
PM setup dialog and multiple frequency selection. 

Description:  Changes and bug fix in PM Setup dialog related to multiple frequency selection 
and use. 
History:  This issue occurred in OMNIC version 6.1. 
 

Autogain limits and trigger intervals. 
Description: Changed the lower limit from 4.5 to 4.0 volts in autogain checking. Also upped the 
minimum trigger interval from 0.01 sec to 0.04 sec. 
History:  This issue occurred in OMNIC version 6.1. 
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OMNIC v6.1 
 
New Features 
Brief descriptions of the new features in OMNIC version 6.1 software suite are provided below.  
 
Added EZ OMNIC support for IR100 and IR200 spectrometers. Add diode laser capabilities 
and verification for the IR100 and IR200 spectrometer to EZ OMNIC. 

Description:  The IR100 and IR200 Series FT-IR spectrometers were designed to meet the 
needs for fundamental infrared analysis, teaching and basic sampling needs. The IR100 and 
IR200 spectrometers also operate with the Encompass software. EZ OMNIC support is now 
provided for those customers that prefer the flexibility of a personal computer with more 
functionality. 

History:  Feature added to EZ OMNIC v6.1 
 

Added support for ECO 3000 FT-IR spectrometer. 
Description:  The ECOTM 3000 is a 300 mm, high-performance, tool used for measuring 
dopant levels in dielectric films (BPSG, PSG, FSG), Hydrogen in SiN/SiON films, epitaxial film 
thickness, MEMS device thickness, and Carbon and Oxygen in Silicon wafers. The ECO 3000 
supports the SEMI standards for 300mm automated wafer handling. 

History:  Feature added to OMNIC v6.1 
 

Added support for Avatar 330 and 370 spectrometers. 
Description:  The Avatar™ 330 and 370 spectrometers are routine analysis FT-IR 
spectrometers that offer packaged solutions for your entire FT-IR process, from data collection 
to reporting the results.  

History:  Feature added to OMNIC v6.1 
 

Added support for Windows XP Professional and Home Editions.   
Description:  Support for Windows XP version is available in this release. Windows XP 
Professional is required with the Digital Signature (DS) option. 

History:  Feature added to OMNIC v6.1 
 

Added the capability to change the font used in all dialog boxes of OMNIC in the 
Edit/Options/View tab.   

Description:  This improves the legibility in the dialogs when fonts for a specific region such as 
in Czechoslovakia or a bolder font is used.   

History:  Feature added to OMNIC and EZ OMNIC v6.1 
 

Added a (GMT-6:00) string to display time zone in the date/time strings used for digital 
signatures. 

Description:  The FDA recently released a guidance document regarding time stamp 
requirements for Part 11 of Title 21 of the Code of Federal Regulations. To aid in a clear 
understanding of the time zone in which an event occurred, a reference to GMT is appended to 
each record of the time written into the Collection and Processing Information.   

History: Feature added to OMNIC v6.1. 
 
Added the capability to digitally sign Macros\Basic (.MAC) file in OMNIC. 

Description:  Macros files play a key role in a system that is subject to the FDA’s 21 CFR Part 
11 regulations as they can be used to enforce permitted sequencing of steps and events. By 
using the Sign File command in the OMNIC File menu, users can sign these files and later 
verify the a macro has a valid digital signature with the Verify File command in the File menu. 
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History:  Feature added to OMNIC v6.1 
 

Removed the checkbox for signing group files in the Edit/Options/Security tab. Also, 
spectral groups are not listed as a file type in the Sign File dialog. 

Description:  The ability to sign group files was confusing to some users. A group file 
consisted of a group of spectra, stored together in a single file. User’s were confused as to the 
meaning of the signature on the file and how it related to the individual spectra in the group file.   

History:  Feature added to OMNIC v6.1 
 

When copying a report to the clipboard, the report is placed in the clipboard as a bitmap as 
well as a metafile. 

Description:  Users now have the option to copy and then paste reports from a report 
notebook into another application as either a bitmap or a Windows metafile. 

History:  Feature added to OMNIC v6.1 
 

Added new ‘GetBenchName’ DDE routine. It gets the bench name and puts it into result 
current. 

Description:  Users can query the spectrometer for its model name. The complete command 
line for this option is described in the Macros on-line help file.  

History:  Feature added to Macros Basic v6.1 and Macros Pro v6.1. 
 

Added new Delay DDE command. It can be used in a macro to delay for a specified number 
of seconds. 

Description:  If a user created a macro where one event must wait for another to complete, the 
user can add a delay into their macro for a specified number of seconds. The complete 
command line for this option is described in the Macros on-line help file. 

History:  Feature added to Macros Basic v6.1 and Macros Pro v6.1. 
 

Enabled the "Other Conversions" menu command in the Process menu of EZ OMNIC. 
Description:  The Other Conversions command that previously was available only in OMNIC, 
now appears in the EZ OMNIC menu. Other conversions allow the user to convert a spectrum 
into Kubelka-Munk, Photoacoustic, %Reflectance, Log (1/R), wavenumber, micrometers or 
nanometers. 

History:  Feature added to EZ OMNIC v6.1 
 

Improved Issues 
 
Substantially decreased the amount of time to start OMNIC for Nexus and Avatar series 
spectrometers. 

Improvement:  When OMNIC is started, the user can now access the OMNIC menus more 
quickly without having to wait until the spectrometer setup has been completed. Note that the 
OMNIC data collection menu items and the bench status indicator will not be enabled until the 
spectrometer setup is complete.  

History: This issue occurred in OMNIC versions 4 through 6.0a. Tracking number:  
ENH03346. 
 

Substantially decreased the amount of time to start OMNIC when using the Digital 
Signature (DS) option on a computer that is not physically connected to a network. 

Improvement:  When OMNIC is started, the user can now access the OMNIC menus more 
quickly without having to wait until the spectrometer setup has been completed. Note that the 
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OMNIC data collection menu items and the bench status indicator will not be enabled until the 
spectrometer setup is complete.  

History: This issue occurred in OMNIC version 6.0a Tracking number:  N/A. 

 
Added capability to capture the user name with every modification that is recorded in 
Collection and Processing Information. 

Improvement:  If the Digital Signature option is installed, OMNIC users are required to enter 
their Windows NT, Windows 2000 or Windows XP username and password to start OMNIC. 
The full user name along with the date-time is recorded in the Collection and Processing 
Information whenever data is collected, modified or signed. Similarly, if a user does not have 
the DS option but has enabled the OMNIC login feature, the OMNIC username and the 
date-time is recorded in the Collection and Processing Information whenever data is collected 
or modified. 

History: This issue occurred in OMNIC version 6.0a. Tracking number:  ENH03110. 
 

If a digitally signed spectrum is modified but not saved, the display of that spectrum would 
change to “Spectrum not signed”. This is not correct as the file saved on disk still has a 
valid signature.   

Improvement:  Now OMNIC automatically detects when spectrum in memory does not match 
file on disk and updates the display of the digital signature as needed for in all OMNIC windows. 
The message “Unable to verify digital signature. The data has been changed” will be displayed 
when a saved spectrum with a digital signature is modified in OMNIC. 

History:  This issue occurred in OMNIC 6.0a. Tracking numbers:  V&V03567 & CST03607. 

 
Record the signing of a spectral file in the Collection and Processing Information. 

Improvement:  When a spectral file is signed, the username, date-time, and the reason for the 
signature are recorded in the Data Processing History section of the Collection and Processing 
Information. 

History:  This issue occurred in OMNIC 6.0a. Tracking number:  CST02891. 
 

Added ability to have an NTFS folder with RWX permission (no delete) and allow spectral 
file saves. 

Improvement:  In previous versions, users need RWX and delete permission to save files to a 
NTFS folder. FDA requirements for electronic records require additional controls on which 
user’s can delete files. A change was made in OMNIC to allow file saving in a NTFS folder 
without requiring users to have delete privileges.  

History:  This issue occurred in OMNIC 6.0a. Tracking number:  CST03359. 
 

Changed atmospheric suppression feature so that during data collection, the suppression 
is only performed if the result is improved when compared to the result from the 
unsuppressed spectra. 

Improvement:  If automatic atmospheric suppression is enabled on the Collect Tab in 
Experiment Setup, the software removes water and carbon dioxide bands from the background 
and sample single beam spectra. When the Absorbance spectrum is calculated, OMNIC will 
perform the processing with and without the suppression applied to the single beams. The 
displayed result will be the resultant Absorbance spectrum with the best baseline 
characteristics. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  ENH03215. 
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Enhanced axis routines to improve annotation capabilities when spectra are displayed in 
wavelength. 

Improvement:  Peaks labels were not being displayed correctly when spectra in wavelength 
were annotated. Note that if a spectrum in wavelength is annotated (for example, peak 
location) and then the spectrum is converted to wavenumbers, the text for the annotation does 
not change. Annotations are static text strings.   

History:  This issue occurred in all prior OMNIC versions. Tracking number: V&V03344. 
 

Add in capability to call DDE annotate command with only 2 arguments, if no text is 
specified use the x or x&y position for the annotation text. 

Improvement:  Simplifies the entering if annotations for the most common use of the DDE 
annotate command.  

History:  This issue occurred in OMNIC 6.0a. Tracking number:  ENH03354. 
 

Add capability to display information from Almega data files such as laser wavelength and 
grating in the Collection and Processing Information when viewed in workstation OMNIC. 

Improvement:  Previously, if the Collection and Processing Information of a Raman spectra 
acquired with an Almega spectrometer was viewed in workstation OMNIC, the Almega 
spectrometer information was incomplete. OMNIC has been enhanced to show the Almega 
spectrometer information in the Collection and Processing Information. 

History:  This issue occurred in OMNIC versions 5.2 through OMNIC version 6.0a. Tracking 
number:  V&V02692. 
 

Changed resource text "The spectra have different Y-axis units." to "The spectra have 
different axis units." This text was used to refer to different X and different Y-axis units. 

Improvement:  The error message a user would see if for example, they tried to add two 
spectra of different x-axis units, is now clearer.    

History:  This issue occurred in OMNIC 6.0a. Tracking number:  V&V03356. 
 

Added cue card help for various tool palettes within OMNIC. 
Improvement:  Right-clicking on the tool palettes icons will bring up context sensitive help for 
that icon.  

History:  This issue occurred in OMNIC versions 4.0 through OMNIC version 6.0a. Tracking 
number:  ENH03360. 
 

Improved COM interface to DDE commands to insert ‘[‘ characters if needed and to properly 
wait for command completion before returning from the command for asynchronous 
commands. 

Improvement:  Enhanced OMNIC’s COM interface to perform it’s own checking for proper 
command syntax and to wait until a previous command has completed before issuing the next 
DDE command. 

History: This issue occurred in OMNIC 6.0a. Tracking number:  N/A. 
 

Added support to add COM objects to OMNIC functionality at run time. 
Improvement:  Enhanced the functionality of OMNIC’s COM interface.   

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  ENH03355. 
 

Resolved Issues 
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OMNIC  
 
Request to store the name and path of the background file in the Collection and Processing 
Information. 

Description:  If the background file comes from the disk, the name and path for the file is 
captured in the Collection and Processing Information.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  ENH02565. 
 

In the Collection and Processing Information, the data collection error information is 
displayed on screen but not printed. 

Description:  OMNIC enhanced to print out all information in the Collection and Processing 
Information.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  CST03442. 
 
If a spectrum was extracted from a notebook, the collection time that appeared in the 
Collection and Processing Information was that of the last spectra from the lab notebook.   

Description:  The collection time that appears in the Collection and Processing Information is 
now that of the extracted spectrum. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02646. 
 
Changed text from "Signature could not be verified" to "Signature could not be verified 
because the necessary software or operating system is not present." This occurs on Win98 
or when DS not purchased. 

Description:  A user can open a digitally signed file on an operating system that does not 
support the encryption tools. Without these tools, OMNIC knows a signature is there but cannot 
decrypt the signature.    

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  N/A. 
 

OMNIC sign read-only files. Put in test for read-only files before attempting to sign them. 
Now puts up an error message when they are read-only 

Description:  If a file is read-only, an error message will be displayed to the user indicating that 
the reason the file cannot be signed is that it is read-only.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  N/A. 
 
Performing a search of a digitally signed spectrum changed the status in the display of that 
spectrum to “Spectrum not signed.” 

Description:  Change made to not change the status of the signature due to a search. 
Searching does not modify the data.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  CST03526 & 
V&V03610. 
 

Unable to configure a custom detector on the right hand side of the spectrometer.   
Description:  Change made in Bench Configuration application to correctly configure 
right-hand custom detectors. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  CST02644 & 
CST02645. 
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Spectral range for XT-KBr beamsplitter and DTGS TE cooled is not correct.   
Description:  With OMNIC 6.0a, the default range for all sources was 4000 – 400 cm-1. A new 
default range of 11,000 – 375 cm-1 has been set for the XT-KBr beamsplitter and DTGS TE 
cooled systems. 

History:  This issue occurred in all prior OMNIC versions. Tracking number:  V&V03368. 
 

Changed to allow reset bench at start of Raman data collection. 
Description:  On the Advanced tab of Experiment Setup, the option to “reset bench at start of 
collection” has been enabled for Raman data collections.  

History:  This issue occurred in all previous OMNIC versions. Tracking number:  V&V03112. 
 

The sample compartment validation wheel for the Avatar does not work with OMNIC 6. 
Description:  The Avatar driver has been modified to control a sample compartment validation 
wheel.  

History:  This issue occurred in OMNIC version 6.0a Tracking number:  V&V02860. 
 

If a Mattson spectrometer had a communication failure when in Experiment Setup, the user 
had to close and then re-open the Experiment Setup dialog to resume communications. 

Description:  Change to OMNIC so that if a communication failure occurs while the user has 
the Experiment Setup dialog open, the user can restart communications without exiting 
Experiment Setup or changing tabs. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03362. 
 

Changed OMNIC to not require a default.cfg file on startup. It creates one if needed now. 
Description:  Default.cfg is installed during the OMNIC installation. If the file is not found on 
startup, OMNIC will now create the file. 

History:  This issue occurred in all prior OMNIC versions. Tracking number:  V&V02877 & 
ENH03369. 
 

Fixed tiny memory leak when a new background is collected. Only a problem for repeated 
background collects over days. 

Description:  Small sections of memory were not being freed after a background collection. 
Over time, this can affect system performance as less memory is available. This has been 
fixed.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03370. 
 

Modify Reprocess to account for the fact that an atmospheric suppression might be done 
on a spectrum with SSP equal to one 

Description:  Reprocess will now account for atmospheric suppression if the Sample Spacing 
Parameter is set to one. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03373. 
 

The Save Group command does not let the user save to a network folder with an UNC path. 
Description:  OMNIC changed to allow UNC paths as the destination folder when saving 
groups. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03393. 
 

OMNIC .SPA files are not associated with the OMNIC application. 
Description:  OMNIC .SPA files will be associated to OMNIC if there is no other association for 
.SPA files in the registry.  
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History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03377. 
 

OMNIC could not read in some older PC-IR data files.   
Description:  Fixed a crash that occurred on some systems when OMNIC tried to read in .SPA 
files created with PC-IR DOS Software.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03371. 
 

If you save a spectrum as a CSV file, the entire spectrum is being saved to the file instead of 
only the displayed region.   

Description:  OMNIC changed so that only the displayed region is saved to the CSV file.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02612. 
 

Mattson files other than .abs are not saved properly. 
Description:  Prompting for before overwriting a Mattson file is only done for .ABS files. No 
prompting if a .RAS, .IFG, or .DRT file is being saved. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02355. 
 

Modified JCAMP-DX to always write out LONGDATE for Y2K compliancy. Additionally, a 
small change to continue writing out JCAMP-DX the old way for dates less than 2000. That 
is 10/04/97 and write out dates new 4 digit way when greater than 1999. 

Description:  Long dates were added into the 5.01 JCAMP specification. This has been 
implemented in OMNIC to assist users with Y2K issues.  

History:  This issue occurred in OMNIC versions 4 through 6.0a. Tracking number:  
V&V02730. 
 

If the spectra were being displayed in wavelength, the only option allowed in for an X-axis 
format in the Display Options was Normal.  

Description:  OMNIC has been changed to allow any of the wavenumber displays when the 
current x-axis format is in wavelength.  

History:  This issue occurred in OMNIC versions 4 through 6.0a. Tracking number:  
V&V02240. 
 

If the Sampling Information, enabled through the Display Setup dialog in the View menu, did 
not fit one a single line, the text would not print. Need to correctly determine width of 
printable area for text wrapping. Fixed issues where if text enabled through Display Options 
wraps, it would not print.  

Description:  Changes made to correctly determine the width of the printable area. Printing, 
wrapping text if necessary, fixed for the Sampling Information.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02759 & 
V&V03395. 
 

Under Display Setup, choosing overlaid titles and displaying sampling information caused 
the text to overlap.    

Description:  Issue has been resolved by moving the sampling information below the overlaid 
titles. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03559. 
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Under Display Setup, choosing overlaid titles and displaying multiple spectra with the 
Digital Signature option installed caused the titles to overlap the signature information on 
the display.  

Description:  Issue has been resolved by moving the digital signature information below the 
overlaid titles. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  CST02891. 
 

The spectral title will not print if an annotation’s starting point was near 2500 cm-1. Also, 
long spectral titles will not print if the title cannot fit on a single line. 

Description:  OMNIC modified to display the spectral title independent of the placement of 
other annotations. Also, corrected error in printing routine to correctly wrap titles that are longer 
than a single line.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02759. 
 

If one copies and pastes an OMNIC window into a program such as MS Word or 
PowerPoint, it is copied with the New Window axis limits instead of the displayed values. 

Description:  Change to OMNIC so that if an OMNIC window is copied and then pasted into 
another application, it appears with the current display limits of the OMNIC window, not the 
values from the Edit/Options/New Window dialog. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03334. 
 

The Getting Started tutorial would intermittently stop running at the 24th screen on 
Windows 2000 systems. 

Description:  There is a documented problem with ToolBook® II applications and Windows 
2000. The issue is supposed to be addressed with Windows 2000 SP3. A workaround has 
been implemented in OMNIC to eliminate the error.  

History:  This issue occurred in OMNIC versions 5 through 6.0a. Tracking number:  
V&V03497. 
 

Enabled cue-card help for Copy and Sign buttons in the report feature. 
Description:  Context sensitive help for the Copy and Sign buttons in View Notebook has been 
added. The help can be accessed by right clicking on the buttons.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03363 
 

If the Roll & Zoom command is chosen, pressing F1 for help brings up the help topic for 
saving configurations. 

Description:  If Roll & Zoom is highlighted in the View menu, the Roll & Zoom help will appear 
if the user presses the F1 key.  

History:  This issue occurred in OMNIC versions 4 through 6.0a. Tracking number:  
V&V02510. 
 

Added new cue-card ID# definitions for spectrum information dialog 
Description:  Context sensitive help was added to the Collection and Processing Information. 
The help is accessed by right clicking on the background area of the dialog.  

History:  This issue occurred in OMNIC versions 4 through 6.0a. Tracking number:  
V&V02512. 
 

Help menu items are not be displayed according to the Edit Menu configuration. 
Description:  A change was made in Edit Menu to not let the user disable or hide menu items 
that are submenu headings such as “Learning OMNIC” and “Sampling Techniques”. Other 
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items in the help menu can now be disabled or hidden as determined by the configuration 
constructed with Edit Menu. 

History:  This issue occurred in OMNIC versions 4 through 6.0a. Tracking number:  
CST03574. 
 

If “Text Only” is selected for the OMNIC Toolbar, the toolbar button separator and the 
button frame do not appear.   

Description:  Changed OMNIC to show the separators and the button frames if “Text Only” is 
selected as the toolbar type.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02497 & 
V&V02714. 
 

The Command Text label in the Add Item Dialog in Edit Menu is not changing consistently 
with the Item Type.  

Description:  Depending upon the Item Type, the title for the Command Text box changes. 
Scenarios existed where the text string did not match the Item type. This has been fixed.  

History:  This issue occurred in OMNIC versions 4 through 6.0a. Tracking number:  V&V02535 
 

The colon after “Experiment” for the experiment drop down control on the main OMNIC 
window is hidden. 

Description:  The Text string was repositioned on the main OMNIC to show the colon. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02537. 
 

Fixed issue when if the computer’s display mode was set to 256 or less colors, the subtract 
auto Y check box could not be checked. 

Description:  In the Subtract window, the auto Y check box can be selected for all video 
display modes on the computer. 

History: This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02673. 
 

Update look of “Change data spacing” dialog to match new OMNIC 6 blue textured look. 
Description:  OMNIC 6 enabled the user to choose the OMNIC Window Style in the 
Edit/Options/View dialog. The style was not applied to the Change Data Spacing dialog in the 
previous OMNIC version. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03367. 
 

Basic Macros and Macros Pro 
 

Some Basic Macros would crash intermittently when run from the OMNIC toolbar.   
Description:  Change made to Macros Basic.  

History:  This issue occurred in Macros Basic version 6.0. Tracking number:  V&V02674. 
 

Modified variance command to put result(s) in current window instead of a new window if 
the command is not invoked from DDE. 

Description:  Change was made in OMNIC so that Variance command functioned the same as 
it had with OMNIC 5.0. By invoking the command: ExecuteOMNIC “Variance 1”, the average is 
calculated and added to current window. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03320. 
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Modified “Statistical Spectra” to not show New Window prompt if command invoked from 
DDE 

Description:  Change was made in OMNIC so that Statistical Spectra functioned the same as 
it had with OMNIC 5.0. By invoking Statistical Spectra though DDE, the result will be added to 
the current OMNIC window. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03320. 
 

InterpretIR+ 
 

InterpretIR+ does not automatically import the active spectrum from OMNIC when 
launched.   

Description:  InterpretIR+ has been changed to automatically import the active spectra when 
InterpretIR+ is launched from the OMNIC Analyze menu. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02713. 
 

Atlµs, µView™ (Microview) and View Stage 
 
Expanded support to allow Atlµs maps to contain up to 50,000 spectra. 

Improvement:  Previous versions of Atlµs allowed users to collect just less than 16K spectra in 
a map. The limit has been increased to 50,000.  

History: This issue occurred in Atlµs v2.5. Tracking number:  ENH03351. 
 

Request to save the image size when Atlµs (or Microview) is closed so that the program 
automatically recalls the values for the user. 

Description:  The last used video size is now saved when Atlµs (or Microview) is closed. The 
saved value is loaded and used when Atlµs (or Microview) is started.  

History:  This issue occurred in Atlµs version 2.5. Tracking number:  V&V00958. 
 

Request to set the number of background and sample scans to different values in Map 
Setup within Atlµs. 

Description:  The user can specify a different number of scans for a background versus a 
sample scan in Atlµs.  

History:  This issue occurred in Atlµs version 2.5. Tracking number:  V&V00637. 
 

Atlµs does not autofocus for each video frame when collecting a mosaic with a map 
Description:  Changed Atlµs so that if "autofocus at each point" is selected/enabled, the 
Mosaic will also autofocus at each point. 

History:  This issue occurred in Atlµs version 2.5. Tracking number:  V&V02693. 
 

Microview opens in a small window after installation. 
Description:  The size of the Microview application has been increased to allow the user to 
more easily view the controls. 

History:  This issue occurred in Microview version 2.5. Tracking number:  V&V02771. 
 

The ruler in the navigation pane of Atlµs cannot be moved with the mouse. 
Description:  Change made so that the if a ruler is drawn in the navigation pane, the arrow tool 
can be used to position the ruler. 

History:  This issue occurred in Atlµs version 2.5. Tracking number:  V&V03313. 
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Clicking on focus control in Atlµs or Microview causes the stage focus to run-on 
unexpectedly 

Description:  The stepping increment for the Z-axis control was changed to a finer granularity. 
The stage moves one increment with each mouse click.  

History:  This issue occurred in Atlµs version 2.5. Tracking number:  V&V02772. 
 

With the View Stage, the Experiment Setup interferogram display freezes after toggling the 
lamp on and then off.   

Description:  View Stage controls in Experiment Setup can now be toggled/changed without 
freezing the interferogram display. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02774 & 
V&V03374. 
 

View Stage users cannot access Atlµs or µView (Microview) correctly. Provide a calibration 
file for the View Stage so that users can then use Atlµs or µView. 

Description:  A View Stage calibration file is needed. The file “ramanvs.cal” has been included 
in the factory folder. 

History:  This issue occurred in Atlµs version 2.5. Tracking number:  V&V02770. 
 

Val-Q 
 
Spectral group collected in Val-Q could not be saved to a network drive. 

Description:  User now has the choice as to where the spectral data is saved. Can be to any 
mapped local or network drive.  

History:  Problem occurs in <Product Name> version <Number>. Added to release notes in 
<Month> <Year>. Tracking number:  CST02895. 
 

OMNIC experiment parameters are not being restored to previous settings when Val-Q 
closes. 

Description:  Val-Q modified to store current OMNIC settings when Val-Q starts and restore 
them when Val-Q closes. 

History:  Problem occurs in <Product Name> version <Number>. Added to release notes in 
<Month> <Year>. Tracking number:  CST03178. 

 
Series 
Fixed bug that prevented import of TGA files into series. 

Description:  A change occurred in OMNIC version 6.0a that prevented TGA files from being 
imported into OMNIC. This has been fixed.  

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02633. 
 

Series and Atlµs progress bar now painted with new OMNIC 6 blue textured dialog style 
colors 

Description:  OMNIC 6 enabled the user to choose the OMNIC Window Style in the 
Edit/Options/View dialog. The style was not applied to the Series or Atlµs progress bars in the 
previous OMNIC version.  

History:  This issue occurred in OMNIC version 6.0a and Atlµs version 2.5. Tracking number:  
V&V03364. 
 

Fixed series setup dialog to only allow values to be entered that create valid series files. 
Prevents attempt to create multi-gigabyte files that caused the display of the size to be a 
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negative number or when the number of spectra exceeded 60000. Modified routine that 
calculates Atlµs map file size to return 0 if resultant file would be larger than is supported. 
Also file creation to return 0 if too many spectra in potential file (more than supported). 

Description:  Some combinations of series collect parameters would cause the Estimated File 
size in the Series Setup dialog to display a negative number as it overflowed the variable. 
Limits and error checking have been added to ensure that a valid estimated file size is 
displayed. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02699. 
 

When profiling Series or Atlµs data, ignore the data spacing test for a measure only method 
Description:  The data spacing is not checked when a measure only method is applied to 
Series or Atlµs data. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  CST03372. 
 

Series collect window does not always update if very data is acquired rapidly.  
Description:  Enhance Series collect so that the current spectrum always updates the display 
even when the time increment is less than one expected increment. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  ENH03376. 
 

Using split bi-directional rapid scan often resulted in dropped scans when going faster than 
about 60 scans per second 

Description:  The time stamp increment for rapid scan was changed to a finer resolution so 
that all scans would have a unique time stamp.     

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02344. 
 

If one uses the same peak and baseline values for the numerator and denominator in Profile 
setup for “Peak height ratio of two peaks”, the Y readout was displayed as “1.#QQ”. 

Description:  Readout now displays the correct value. 

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V03322. 
 

Almega 
 
Added Photobleach time to collect tab; removed estimated resolution as it is on the Bench 
tab. 

Description:  New Feature.  

History:  Feature added to OMNIC for Almega v6.1. 
 

Added partial wavelength calibration feature. This lets the user select a subset of spectral 
ranges to calibrate if they don’t want to take the time to calibrate all ranges. 

Description:  New Feature.  

History:  Feature added to OMNIC for Almega v6.1. 
 

Changed the alignment procedure to start at the center and spiral out rather than raster a 
rectangle. 

Description:  New Feature.  

History:  Feature added to OMNIC for Almega v6.1. 
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Coarse adjustment needs a finer scale. 
Description:  Coarse adjustment increment reduced. Allows for smoother operation and less 
overshoot.  

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  V&V03598 
 

If the focus button is clicked rapidly with a 50x objective, the focus motors may not be able 
to bring the object back in focus. Manual refocusing required. 

Description:  Coarse adjustment increment reduced. Allows for smoother operation and less 
overshoot.  

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  V&V03601 
 

The signal is not changing during autoalign if option 3, align laser to pinhole, is selected. 
Description:  <Insert Description Here>.  

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  V&V03570. 
 

Wavelength calibration. Improved algorithms to make calibration more robust. 
Description:  Added code to adjust spectrograph focal length for best fit. Added neon lines 
(neonhigh.txt and neonlow.txt files) to do a better job covering the spectral range for each 
grating position. Removed some chronically mismatched neon lines. Results are saved in a 
single file, calibrate.txt, rather than individual peak####.txt files. 
 
History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Laser calibration improvements. 
Description:  Changed peak location algorithm to use center-of-gravity. Modified procedure so 
that second laser is calibrated even if first laser fails. Fixed bug that caused some single laser 
configurations to hang up. Fixed bug so that a combined bin range is calculated for single laser 
systems. 
 
History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Almega Installation Issues. 
Description:  Removed code which caused default.con and default.exp files to be write 
protected. Fixed issue which installed the WinNT 4.0 driver under Windows 2000 in addition to 
the Windows 2000 driver. 
History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Do laser accordian before Set_fold_limits to get desired range. 
Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Require a laser normalize for atypical laser type spectrometers. 
Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Add methods to calculate the resolution information for atypical lasers. 
Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
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Changed startup code to detect when bench power is off and prevent showing multiple 
camera errors. 

Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Added initialization code so that the correct grating is selected when entering the Bench or 
Align tab. This also fixes bug, which caused occasional blank spectral range text boxes 
when selecting 532 Low Res grating. 

Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Automatic data spacing option on Advanced tab not always selected by default. Changed 
so it is initialized to checked. 

Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Turn both lasers On/Off option on Advanced tab does not stay selected. Disable this option 
if only one laser installed. 

Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A./A. 
 

Fixed bug that occasionally introduced a blank data point in spliced spectra. 
Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Added code to bin-in-memory collects to check for CCD traps. 
Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Modified DDE commands so that calibrations can be run from macro (no finish dialog) and 
un-invoked collects finish correctly. 

Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

Spectrograph alignment tab changed so that if LED is at high intensity during pinhole align, 
Max contains "(H)", if at low intensity it contains "(L)". 

Description:   

History:  Issue occurred in OMNIC for Almega v6.0a. Tracking number:  N/A. 
 

SST and TRS 
Added multiple scan capability to all of the Step Scan menus. 

Description:  New Feature. 

History:  This feature was added in OMNIC version 6.1. Tracking number:  N/A. 
 

Added multiple trigger for Time Resolved Step Scan (TRS). 
Description:  New Feature. 

History:  This feature was added in OMNIC version 6.1. Tracking number:  N/A. 
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Provide TRS drivers for Gage acquisition boards on the Thermo Nicolet installation CD 
Description:  New Feature. 

History:  This feature was added in OMNIC version 6.1. Tracking number:  N/A. 
 

Reduced the minimum trigger interval required for TRS experiments. 
Description:  New Feature. 

History:  This feature was added in OMNIC version 6.1. Tracking number:  N/A. 
 

Advanced diagnostic test parameters for TRS for the Gage 8500 board were not optimal. 
The number of samples is being set to zero. 

Description:  The 8500 board is a faster board. Parameters have been updated.     

History:  This issue occurred in OMNIC version 6.0a. Tracking number:  V&V02542. 
 

Known Issues 
 
IR Spectral Interpretation will not display the functional group information (accessed by 
clicking on the eyeglasses) if Library Manager is open. 

Description:  IR Spectral Interpretation will not display the functional group information 
(accessed by clicking on the eyeglasses) if Library Manager is open 

Recommendation:  The Library Manager window must be closed to view the functional group 
information and structures. 

History:  Problem occurs in OMNIC 6.1 
 
 

OMNIC Installation Directories 
 
When you install OMNIC the default (recommended) directories depend on whether an earlier 
version of OMNIC is on your system. 
 
If an earlier version is not present, the default folders are C:\My Documents\OMNIC for data files, 
and C:\Program Files\OMNIC for program (executable) files and Help files. Within the C:\My 
Documents\OMNIC folder, the following folders will be created:  Autosave for saving spectra 
automatically after a data collection, Icons for icon image files you can use when customizing the 
OMNIIC toolbar, Libs for spectral library files, Log for the OMNIC log (if enabled), Macros for 
OMNIC macro files, Quant for quantitative analysis methods, Param for experiment files and 
configuration files, Report for report notebooks, and Spectra for spectral data files. Other optional 
software programs may add other folders to the C:\My Documents\OMNIC folder.  
 
If an earlier version of OMNIC is present, the default data directory is the directory where the earlier 
version was installed (usually C:\OMNIC). The default directory for program files is where the 
earlier version was installed (usually C:\Program Files\OMNIC). 
 
In either case, you can specify that other directories be used if desired. 
 
In addition to these directories, OMNIC installs the runtime ToolBook® 5.0 files in the 
Windows\Asym\Runtime directory and the runtime ToolBook 6.0 files in the Program Files\ 
Asymetrix\Shared Tools\tbsystem directory. These files are used by OMNIC Macros\BasicTM and 
the tutorials. 
 
 
Problems? 
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For Technical Support, please contact: 
Thermo Fisher Scientific 
5225 Verona Road 
Madison WI  53711-4495 U.S.A. 
Telephone:  1 800 532 4752  
E-mail:  us.techsupport.analyze@thermofisher.com 
World Wide Web:  http://www.thermo.com/spectroscopy 
 
For International Support, please contact: 
Thermo Fisher Scientific  
Telephone:  +1 608 273 5017  
E-mail:  support.madison@thermofisher.com 
World Wide Web:  http://www.thermo.com/spectroscopy 
 
Microsoft, Windows, Windows NT and Windows Vista are either trademarks or registered 
trademarks of Microsoft Corporation in the United States and/or other countries. 
ToolBook is either a trademark or registered trademark of click2learn.com, inc. in the United States 
and/or other countries. 
PerkinElmer is either a trademark or registered trademark of PerkinElmer, Inc. in the United States 
and/or other countries. 
Sadtler and SearchMaster are trademarks of Bio-Rad Laboratories, Inc. in the United States and/or 
other countries. 
Bruker and OPUS are either trademarks or registered trademarks of Bruker Optics, Inc. in the 
United States and/or other countries. 
All other trademarks are the property of Thermo Fisher Scientific Inc. and its subsidiaries. 
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	Peak height ratio and Peak area ratio metrics available in reprocess.
	Kinetics.
	New Array menu items.

	MACROS PRO
	Replaceable collect prompts.
	Interferogram peak level readable from Nicolet Series instruments.
	Environment variables supported in run commands

	OMNIC DS
	Administrator program requires username and password at startup.
	Administrator program handles large networks better.
	Administrator program more easily adds or removes access control entries for all access control functions.
	Support for signing Libraries.
	Support for signing spectral group files (.spg).
	Sign multiple files with a single authentication prompt
	Sign the selected spectra without using a file navigation dialog.

	Atlµs v7.1
	Support for Nicolet Series Bench

	Resolved Issues
	OMNIC
	Company Name change
	Current Tool changed after running a Macros Basic macro
	Spectrum title corrupted by Automatic Baseline Correct.
	Asterisk appended to spectrum filename
	X Axis not drawn at start of data collect
	X Axis always in decreasing order in Collect Window
	X Axis limits changed at end of Raman collect
	Multiple copies of Spectral Group files sent with Mail Spectra
	Collection and Processing Window garbled after closing spectral window
	Interferogram peak not in display window of Experiment Setup
	Overlay feature of Search results does not work when decimal point is a comma
	Use Fixed Scale during data collect not applied to interferogram collects
	Buttons at bottom of Experiment Setup and Options cutoff when large fonts are used
	Dialog font intermittently incorrect
	Extended Search text fields too short
	Green check appears before bench communications established
	Loading an old (pre 7.0) experiment file does not reset new fields
	Problems with beamsplitter recognition on Nicolet Series instruments

	OMNIC DS
	Editing annotation in the Annotation Information dialog corrupts signature status display.

	Known Issues
	Tabbing in Options and Experiment Setup does not move between controls.
	Inserting a smart accessory during a data collect.


	OMNIC v7.0
	New Features
	OMNIC
	Anti-collision for annotations in Find Peaks.
	Support for Nicolet Series instruments.
	Grid of controls used on Bench tab of Experiment Setup.
	Freeze button on Bench and Diagnostic tabs of Experiment Setup.
	New Configure tab of Experiment Setup.
	X Limits of live display persist in Experiment Setup.
	Background scans optionally set separate from Sample scans.
	Option to set Y-Limits for use during collect.
	Auto-blank regions during data collect.
	Marco assigned to front panel button on instrument.
	Improved peak annotations.
	Annotations viewable as a table.
	Mail Spectra.
	Additional Y Scaling buttons.
	List of spectral titles auto-sizes.
	Additional techniques supported for Derivative.
	Overlay spectra in Search Results window.
	Multifile .SPC file read.
	New look for tabbed dialogs.
	Saving spectra from Spectral Group files now defaults to saving as individual files.
	Floating-point exceptions now handled more gracefully.

	OMNIC DS
	Administrator program translated.
	Warning at OMNIC start for invalid directory policies.

	SST and TRS
	Synch Hold Addition to SST

	Resolved Issues
	OMNIC
	Collect time-out when set to ssp1 @ .125 cm-1 resolution with PCI card
	Problems showing data in increasing X order fixed.
	File types recorded separately for Open and Delete file dialogs.
	Filename now shows when bitmap pasted into external program.
	Mpanel32.exe no longer installed.
	Collection and Bench parameters saved in new user libraries for each spectrum.
	Spectrum filename can be displayed in Search window.
	Improved parsing of OMNIC command line.
	Changes made to spectra extracted from report do not affect report display.

	OMNIC DS
	Saving data to protected directories works as installed.
	Problems signing files after password change on Windows XP fixed.
	Print feature of Search window now uses printing policy correctly.
	Spectra extracted from library can now be printed regardless of printing policy.
	Windows key no long gives access to explorer features in open/save dialogs.
	Event log entries now made for file deletions for GAML files.


	OMNIC v6.2
	New Features
	OMNIC
	Read/Write GAML files.
	New Advanced ATR correction.
	Insertion and deletion date now available for library spectra.
	Spectra deleted from user libraries remain visible until the library is compressed.
	Display help files in three-pane mode.
	Resizing Open/Save dialogs.
	Remember size of Spectrum information window
	Record old data spacing for Change Data Spacing
	Raman operations generate history records.
	Change Data Spacing history now includes old data spacing.

	OMNIC DS
	Admin program for configuring user authorization.
	Reasons for Digital Signatures controlled by Admin program.
	Event Log for significant events.
	Saving data to directories with restricted access.
	Sign file gives three chances to enter correct password.

	SST and TRS
	New Sample Spacing choices
	Improved multiple-trigger mode
	Resolution selection for step-scan time-resolve
	Y-axis added to TRSS real-time display
	Step-Scan Settling time now set with edit control

	Resolved Issues
	OMNIC
	Change the default setting for the Bench and Collect checkboxes to off in the Quant Setup dialog.
	Change how the spectral limits in a new Raman library will be created.
	Change to not display an error when a user chooses not to overwrite a signed file.
	Fixed a bug that occurred when OMNIC was installed in a path that used multi-byte Japanese characters.
	On a clean install, the default for peak picks will be sorted on Position, not intensity.
	Setting access rights to temporary directory.
	Turn off display of signature information in reports.
	Spectra from signed .spa files appear modified when loaded.
	Change to allow up to 10000 series files in sequence rather then 100.
	Cleanup drawing flaws in skinned dialogs.
	Fixed a bug that would disable the spectrometer tour by mistake in some cases.
	MRU list saved on a per-user basis.
	OMNIC sub-installers have been changed to use Microsoft Installer.
	Spikes in files converted from Perkin Elmer format fixed.
	Undo Scale must be done twice.
	Raman Instrument correct works with a reference file.
	Options changes recognized in Find Peaks window.
	Drawing shaded regions on 32 bit depth ATI cards changed.
	Additional message generated if file signing canceled.
	References to Thermo web site changed.
	Crash when invalid gain read from a file.
	More scans button on collect window disabled for Mattson.
	Failure to overwrite read-only configuration files now reported.
	Failure of Change data spacing now reported.
	Hourglass cursor now shown during Other Conversions.
	Digital Signature status not shown properly for Almega spectra
	Text drawing bug in collect status window fixed
	Spectra filename lost after an undo operation fixed
	Crash when adding very long annotation fixed
	Remove DC offset from interferograms read from Mattson files.
	Normalize Scale command failed when performed twice.
	Change to the default value in Quant setup.
	Raman data added to library had poorly registered X-axis values.
	Initial directory for Configuration files is now the same as parameter files
	GC-FTIR External trigger feature fixed

	SST and TRS
	Display of Channel B/A ratio in PEM setup dialog
	Collect time-out problem in step-scan dialogs.
	Phase Analysis dialog.
	SST menu item names.


	OMNIC v6.1a
	Resolved Issues
	OMNIC
	The new GMT time zone information in the Data Display Information section of the Spectral History is displayed improperly when on the positive side of the grand meridian.
	Changed the Spectrometer Tour routine to not check the CDROM drive for the tour.
	Rapid scan collects stalled on Windows NT 4.0 systems.
	Intermittent driver problem could result in a system lockup during data collect.

	InterpretIR+
	InterpretIR+ did not install from the Update CD.

	Val-Q
	Some Autotest results report failures when run under some foreign languages.
	Autotest report four failures when run on a system that does not have the DS option installed.

	View Stage
	Cannot view data during data collection.

	Almega
	Photobleaching not operating properly.
	Slit selection changing when switching tabs.
	Display limits when viewing data in nanometers..
	Updating previous Almega installations with the Update CD.

	SST and TRS
	PM setup dialog and multiple frequency selection.
	Autogain limits and trigger intervals.


	OMNIC v6.1
	New Features
	Added EZ OMNIC support for IR100 and IR200 spectrometers. Add diode laser capabilities and verification for the IR100 and IR200 spectrometer to EZ OMNIC.
	Added support for ECO 3000 FT-IR spectrometer.
	Added support for Avatar 330 and 370 spectrometers.
	Added support for Windows XP Professional and Home Editions.
	Added the capability to change the font used in all dialog boxes of OMNIC in the Edit/Options/View tab.
	Added a (GMT-6:00) string to display time zone in the date/time strings used for digital signatures.
	Added the capability to digitally sign Macros\Basic (.MAC) file in OMNIC.
	Removed the checkbox for signing group files in the Edit/Options/Security tab. Also, spectral groups are not listed as a file type in the Sign File dialog.
	When copying a report to the clipboard, the report is placed in the clipboard as a bitmap as well as a metafile.
	Added new ‘GetBenchName’ DDE routine. It gets the bench name and puts it into result current.
	Added new Delay DDE command. It can be used in a macro to delay for a specified number of seconds.
	Enabled the "Other Conversions" menu command in the Process menu of EZ OMNIC.

	Improved Issues
	Substantially decreased the amount of time to start OMNIC for Nexus and Avatar series spectrometers.
	Substantially decreased the amount of time to start OMNIC when using the Digital Signature (DS) option on a computer that is not physically connected to a network.
	Added capability to capture the user name with every modification that is recorded in Collection and Processing Information.
	If a digitally signed spectrum is modified but not saved, the display of that spectrum would change to “Spectrum not signed”. This is not correct as the file saved on disk still has a valid signature.
	Record the signing of a spectral file in the Collection and Processing Information.
	Added ability to have an NTFS folder with RWX permission (no delete) and allow spectral file saves.
	Changed atmospheric suppression feature so that during data collection, the suppression is only performed if the result is improved when compared to the result from the unsuppressed spectra.
	Enhanced axis routines to improve annotation capabilities when spectra are displayed in wavelength.
	Add in capability to call DDE annotate command with only 2 arguments, if no text is specified use the x or x&y position for the annotation text.
	Add capability to display information from Almega data files such as laser wavelength and grating in the Collection and Processing Information when viewed in workstation OMNIC.
	Changed resource text "The spectra have different Y-axis units." to "The spectra have different axis units." This text was used to refer to different X and different Y-axis units.
	Added cue card help for various tool palettes within OMNIC.
	Improved COM interface to DDE commands to insert ‘[‘ characters if needed and to properly wait for command completion before returning from the command for asynchronous commands.
	Added support to add COM objects to OMNIC functionality at run time.

	Resolved Issues
	OMNIC
	Request to store the name and path of the background file in the Collection and Processing Information.
	In the Collection and Processing Information, the data collection error information is displayed on screen but not printed.
	If a spectrum was extracted from a notebook, the collection time that appeared in the Collection and Processing Information was that of the last spectra from the lab notebook.
	Changed text from "Signature could not be verified" to "Signature could not be verified because the necessary software or operating system is not present." This occurs on Win98 or when DS not purchased.
	OMNIC sign read-only files. Put in test for read-only files before attempting to sign them. Now puts up an error message when they are read-only
	Performing a search of a digitally signed spectrum changed the status in the display of that spectrum to “Spectrum not signed.”
	Unable to configure a custom detector on the right hand side of the spectrometer.
	Spectral range for XT-KBr beamsplitter and DTGS TE cooled is not correct.
	Changed to allow reset bench at start of Raman data collection.
	The sample compartment validation wheel for the Avatar does not work with OMNIC 6.
	If a Mattson spectrometer had a communication failure when in Experiment Setup, the user had to close and then re-open the Experiment Setup dialog to resume communications.
	Changed OMNIC to not require a default.cfg file on startup. It creates one if needed now.
	Fixed tiny memory leak when a new background is collected. Only a problem for repeated background collects over days.
	Modify Reprocess to account for the fact that an atmospheric suppression might be done on a spectrum with SSP equal to one
	The Save Group command does not let the user save to a network folder with an UNC path.
	OMNIC .SPA files are not associated with the OMNIC application.
	OMNIC could not read in some older PC-IR data files.
	If you save a spectrum as a CSV file, the entire spectrum is being saved to the file instead of only the displayed region.
	Mattson files other than .abs are not saved properly.
	Modified JCAMP-DX to always write out LONGDATE for Y2K compliancy. Additionally, a small change to continue writing out JCAMP-DX the old way for dates less than 2000. That is 10/04/97 and write out dates new 4 digit way when greater than 1999.
	If the spectra were being displayed in wavelength, the only option allowed in for an X-axis format in the Display Options was Normal.
	If the Sampling Information, enabled through the Display Setup dialog in the View menu, did not fit one a single line, the text would not print. Need to correctly determine width of printable area for text wrapping. Fixed issues where if text enabled ...
	Under Display Setup, choosing overlaid titles and displaying sampling information caused the text to overlap.
	Under Display Setup, choosing overlaid titles and displaying multiple spectra with the Digital Signature option installed caused the titles to overlap the signature information on the display.
	The spectral title will not print if an annotation’s starting point was near 2500 cm-1. Also, long spectral titles will not print if the title cannot fit on a single line.
	If one copies and pastes an OMNIC window into a program such as MS Word or PowerPoint, it is copied with the New Window axis limits instead of the displayed values.
	The Getting Started tutorial would intermittently stop running at the 24th screen on Windows 2000 systems.
	Enabled cue-card help for Copy and Sign buttons in the report feature.
	If the Roll & Zoom command is chosen, pressing F1 for help brings up the help topic for saving configurations.
	Added new cue-card ID# definitions for spectrum information dialog
	Help menu items are not be displayed according to the Edit Menu configuration.
	If “Text Only” is selected for the OMNIC Toolbar, the toolbar button separator and the button frame do not appear.
	The Command Text label in the Add Item Dialog in Edit Menu is not changing consistently with the Item Type.
	The colon after “Experiment” for the experiment drop down control on the main OMNIC window is hidden.
	Fixed issue when if the computer’s display mode was set to 256 or less colors, the subtract auto Y check box could not be checked.
	Update look of “Change data spacing” dialog to match new OMNIC 6 blue textured look.

	Basic Macros and Macros Pro
	Some Basic Macros would crash intermittently when run from the OMNIC toolbar.
	Modified variance command to put result(s) in current window instead of a new window if the command is not invoked from DDE.
	Modified “Statistical Spectra” to not show New Window prompt if command invoked from DDE

	InterpretIR+
	InterpretIR+ does not automatically import the active spectrum from OMNIC when launched.

	Atlµs, µView™ (Microview) and View Stage
	Expanded support to allow Atlµs maps to contain up to 50,000 spectra.
	Request to save the image size when Atlµs (or Microview) is closed so that the program automatically recalls the values for the user.
	Request to set the number of background and sample scans to different values in Map Setup within Atlµs.
	Atlµs does not autofocus for each video frame when collecting a mosaic with a map
	Microview opens in a small window after installation.
	The ruler in the navigation pane of Atlµs cannot be moved with the mouse.
	Clicking on focus control in Atlµs or Microview causes the stage focus to run-on unexpectedly
	With the View Stage, the Experiment Setup interferogram display freezes after toggling the lamp on and then off.
	View Stage users cannot access Atlµs or µView (Microview) correctly. Provide a calibration file for the View Stage so that users can then use Atlµs or µView.

	Val-Q
	Spectral group collected in Val-Q could not be saved to a network drive.
	OMNIC experiment parameters are not being restored to previous settings when Val-Q closes.

	Series
	Fixed bug that prevented import of TGA files into series.
	Series and Atlµs progress bar now painted with new OMNIC 6 blue textured dialog style colors
	Fixed series setup dialog to only allow values to be entered that create valid series files. Prevents attempt to create multi-gigabyte files that caused the display of the size to be a negative number or when the number of spectra exceeded 60000. Modi...
	When profiling Series or Atlµs data, ignore the data spacing test for a measure only method
	Series collect window does not always update if very data is acquired rapidly.
	Using split bi-directional rapid scan often resulted in dropped scans when going faster than about 60 scans per second
	If one uses the same peak and baseline values for the numerator and denominator in Profile setup for “Peak height ratio of two peaks”, the Y readout was displayed as “1.#QQ”.

	Almega
	Added Photobleach time to collect tab; removed estimated resolution as it is on the Bench tab.
	Added partial wavelength calibration feature. This lets the user select a subset of spectral ranges to calibrate if they don’t want to take the time to calibrate all ranges.
	Changed the alignment procedure to start at the center and spiral out rather than raster a rectangle.
	Coarse adjustment needs a finer scale.
	If the focus button is clicked rapidly with a 50x objective, the focus motors may not be able to bring the object back in focus. Manual refocusing required.
	The signal is not changing during autoalign if option 3, align laser to pinhole, is selected.
	Wavelength calibration. Improved algorithms to make calibration more robust.
	Laser calibration improvements.
	Almega Installation Issues.
	Do laser accordian before Set_fold_limits to get desired range.
	Require a laser normalize for atypical laser type spectrometers.
	Add methods to calculate the resolution information for atypical lasers.
	Changed startup code to detect when bench power is off and prevent showing multiple camera errors.
	Added initialization code so that the correct grating is selected when entering the Bench or Align tab. This also fixes bug, which caused occasional blank spectral range text boxes when selecting 532 Low Res grating.
	Automatic data spacing option on Advanced tab not always selected by default. Changed so it is initialized to checked.
	Turn both lasers On/Off option on Advanced tab does not stay selected. Disable this option if only one laser installed.
	Fixed bug that occasionally introduced a blank data point in spliced spectra.
	Added code to bin-in-memory collects to check for CCD traps.
	Modified DDE commands so that calibrations can be run from macro (no finish dialog) and un-invoked collects finish correctly.
	Spectrograph alignment tab changed so that if LED is at high intensity during pinhole align, Max contains "(H)", if at low intensity it contains "(L)".

	SST and TRS
	Added multiple scan capability to all of the Step Scan menus.
	Added multiple trigger for Time Resolved Step Scan (TRS).
	Provide TRS drivers for Gage acquisition boards on the Thermo Nicolet installation CD
	Reduced the minimum trigger interval required for TRS experiments.
	Advanced diagnostic test parameters for TRS for the Gage 8500 board were not optimal. The number of samples is being set to zero.

	Known Issues
	IR Spectral Interpretation will not display the functional group information (accessed by clicking on the eyeglasses) if Library Manager is open.
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